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Key Numbers 
You should receive two standard keys for each cabinet.  Each key should have a tag that indicates 
the key’s cabinet and cabinet location.  It is recommended that you store one key in a safe, 
secured place, and make the other key available to authorized users who may need it during 
power failures, etc.   

Use the following chart to record your key numbers.  For each key, record the location, tower, 
and key number.   

You can also use this chart as part of your backup plan for distributing keys during a power 
failure or other event that prevents normal supply dispensing.  In the Key Taken By column, 
record the name of the user who has taken a key, and use the Out and In columns to record the 
date/time.  Be certain to inform your users of the policy and procedure for accessing 
SupplySource by using keys. 

You may make copies of this chart to list additional departments. 
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Introduction to the Control Center 
The Control Center is a windows-style software application that runs on your own networked PC.  
The Control Center allows you to enter, monitor, and modify data in the SupplySource database.  
This manual contains step-by-step instructions for using the Control Center to maintain and 
manage your SupplySource System, and it provides an administrative overview of all system 
components and functions. 

You can perform the following tasks with the Control Center: 

1. Define the characteristics of the supplies in your database 
2. Assign supplies to SupplySource Towers 
3. Create accounts for all system users, and assign activity privileges to each 
4. Enter, monitor, and retrieve patient data 
5. Customize and configure the system to meet your needs 

SupplySource is provided with the number of Control Center licenses you purchased, and each 
application is installed on the computer you designated.  To purchase and install additional 
Control Center applications, contact your MedSelect Sales Representative. 
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Overview of SupplySource 
The following section is an overview of the SupplySource system, including a description of the 
components and their uses.  An explanation of operating procedures, system care, and safety 
considerations follows the component descriptions. 

Description of Components 

SupplySource will include the following devices: 

Display Terminal  
The Display Terminal is a computer with a touch-screen 
display that makes it possible to dispense supplies for a 
selected patient, access supply and patient information, 
and restock the system inventory.   

For more information on using the Display Terminal, see 
the SupplySource Display Terminal Dispensing Guide. 

 
SupplySource Tower (SST) 
The SupplySource Tower provides convenient yet 
controlled access to supplies. The Tower shelves can be 
configured in a variety of ways to provide a multitude of 
storage options.  
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Troubleshooting Tips 

There is not usually a need to power off the system database server, except for servicing by 
authorized MedSelect service personnel.  The following circumstances occur when a device is 
powered off: 

• If only the database server is powered off, the Display Terminals continue to operate in an 
offline mode with limited functionality.  Full functionality is restored when the database 
server is brought online.  All windows on the Display Terminal display a red title bar to 
indicate that the server is not available.   

• If the IB Module is unplugged or powered off, dispensing from the Display Terminal is not 
possible.   

Care of the System 

Do not use solvents, liquid cleaners or aerosol cleaners to clean any part of the SupplySource 
System.  Use a soft, slightly damp cloth and warm, soapy water for cleaning cabinet surfaces.  
Use a soft cloth and a small amount of glass cleaner to clean the Display Terminal’s touch 
screen. 
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Safety Precautions 
The SupplySource System is clearly marked to protect the user from possible injury or damage to 
the system.  The following symbols may be found on system components: 

 

The exclamation point inside a triangle indicates caution.  
When you see this symbol, refer to this instruction 
manual in order to protect against damage to the 
SupplySource System. 

 

The lightning bolt inside a triangle indicates hazardous 
voltage inside.  Do not attempt to open or access the 
interior of a device marked with this symbol. 

 

This symbol indicates a circuit common connected to a 
grounded chassis. 

 

The Warning label denotes a hazard.  It calls attention to 
a procedure or practice which, if not correctly performed 
or adhered to, could result in personal injury.  Do not 
proceed beyond a warning label until the indicated 
conditions are fully understood and met. 

 

The Caution label denotes a hazard.  It calls attention to 
an operating procedure or practice which, if not correctly 
performed or adhered to, could result in damage to or 
destruction of part or all of the product.  Do not proceed 
beyond a caution label until the indicated conditions are 
fully understood and met. 
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Equipment marked with the label pictured below should not be opened by system users.  
Otherwise, system damage may occur. 

 

Contact your MedSelect Service Representative for system service.  There are no user serviceable 
parts in the SupplySource System.  Equipment used in a manner not specified in this document 
by MedSelect Inc. may impair the protection provided by the equipment. 
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Electrical Requirements 

This system requires a single-phase, three-wire, unswitched wall receptacle.  A grounded, 3-
prong power receptacle must be available for connecting main AC power to the Display 
Terminal, IB Module, and optional printer power Supply.  In the event that your facility does not 
have adequate electrical outlets, use only a qualified electrical contractor to perform work on 
electrical circuits.  Do not attempt to defeat the safety purpose of the grounding-type plug.  You 
may need to consult the hospital’s Engineering department before performing electrical work.   

The power requirements of system components are as listed in the table below.   

Device Nominal Input 
Power 

Max Power 
Consumption(VA) 

Max Power Consumption 
Rating(W) 

Printer 
(Epson) 

115VAC, 60Hz, 
single phase 

85VA 50W 

IB Module 115VAC, 60Hz, 
single phase 

135VA 80W 

DT 2.0 115VAC, 60Hz, 
single phase 

200VA 120W 
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Ventilation Requirements 

There are no special ventilation requirements for the equipment covered by this manual, unless 
your system includes an optional Display Terminal printer.  The printer’s power supply is a 
separate unit and should never be covered or mounted in any way that restricts its ventilation 
louvers. Restricting air circulation around this unit could reduce its operating life. 
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Accessing and Tracking Supplies During Power Outages or Display 
Terminal Failures 
If all power sources should fail and the Display Terminal becomes inoperable, you must open the 
dispensing cabinets with their proper keys.  These keys should be secured by an authorized staff 
member who can make them available during a power outage (see page viii).   

During a power outage, the system is not able to track inventory.  You must keep track of 
supplies used and then adjust the system quantities when power is restored.  You should work 
with your system administrator to develop a plan for manually recording supply usage during 
power emergencies. 
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Hardware and Software Requirements for Control Center Installation 
The Control Center can be installed on a PC that is on the same network as the SupplySource 
server.  The PC must meet the following requirements: 

Components Requirements 
Microprocessor Pentium 90 or higher 
RAM 32MB of RAM or higher 
Hard Disk 15MB to install and run the Control Center 

85MB to install Examiner (50MB will be given back after the 
installation) 
30MB to run Examiner 
Total required to run Control Center and Examiner =50MB 

Video Monitor EGA or higher 
Operating Systems Microsoft Windows 95, NT 4.0, or Windows 2000 
Keyboard Required 
Mouse A mouse is strongly recommended but not required 

 
Do not install the Control Center on a computer running Windows 3.11 or any other version 
prior to Windows 95.   The Control Center can only be installed by MedSelect service 
personnel. 
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Contacting the MedSelect Customer Support Center 
MedSelect customer support is available 24 hours a day, 7 days a week, 365 days a year.  If you 
have questions about SupplySource that are not answered by this document, you can contact the 
MedSelect Customer Support Center at 1-800-508-4576. 
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Part One: System Configuration at Installation 

SupplySource configuration refers to 
the addition, removal, or modification 
of any system component.  Part One 
of this manual is designed to be used 
by a MedSelect associate in assisting 
the system administrator with the 
configuration.  It assumes the user is 
familiar with the Control Center, and 
is intended for use only by 
experienced system installers or 
administrators. 
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Login and Preparation 
Before you can accomplish any work in SupplySource, you must log in to the Control Center, 
then add yourself as a system user and grant yourself all of the access rights you need to perform 
various high-level functions.  If you already have a user account for yourself, you can skip to 
Configuration Overview on page 13.  These instructions only work if the default administration 
login has never been used. 

 To login and add your own user record (new system only) 

1. Start the Control Center. 

2. Type your Username as CCADMIN. 

3. Press the TAB key to move the cursor to the next line. 

4. Type your PIN as 9999 then press ENTER. 

9999 is a default PIN.  When you enter this, you are prompted to change the PIN.  Change 
the PIN to a number only you will know.  This new number you enter is the default 
administrator’s PIN from now on. 

5. Under the Maintenance menu, select User, then select User Browser. 

6. Click the Add button. 

7. Type the requested information about yourself in each field on the User Detail form.  Be sure 
to enter the Username that you wish to use when logging in to the Control Center. 

8. Select all of the user access rights in the right hand column.  

This gives you full access to all system functions.  When you have become more familiar 
with the system, you may want to change your access rights. 

9. Click the Save button to save changes.   

10. Close down the Control Center application, then restart it. 

11. Login with the new Username and PIN.  The PIN is 9999. 

12. Follow the prompts to create your unique PIN number. 
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Configuration Overview 

Defining the Areas in Your Hospital or Facility 

SupplySource recognizes different areas of your facility by organizing them into locations and 
departments. 

Locations - Areas in your facility where activity impacts SupplySource in any way.  These could 
be patient rooms, stock rooms, storage closets, nursing stations, hallways, labs, etc.  There may or 
may not be SupplySource devices in these locations (such as in a patient room). 

Department - A collection of locations and Display Terminals.  Departments can define 
attributes that can be set globally for all of the Display Terminals they contain. 

To enter this information, it is best to work from the top down in the following manner: 

1. Create departments first. 

2. Add locations. 

3. Add Display Terminals, choose a default location for each, and assign them to the 
departments. 

4. Assign additional locations to the Display Terminals. 

The following sections guide you through these steps. 
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Step 1: Creating Departments 
Departments are divisions of your facility that may define unique attributes for the parts of the 
SupplySource System they contain. 

 To add a new department 

1. Under the Maintenance menu, select Department. 

2. Click the Add button on the toolbar. 

3. Enter the department name and set each attribute as desired.  For a description of each 
option, see Department Maintenance Fields on page 107. 

4. Click the Save button on the toolbar. 

 To delete a department 

1. Select the department from the department browser. 

2. Click the Delete button on the toolbar. 

3. You are asked to confirm the deletion.  Click the Yes button to confirm, or click the No 
button to cancel. 

4. Click the Save button on the toolbar. 

Note that the data is not removed from the database until you save. 

_____________________________________________________________________________  

Note: To protect the integrity of the database, you may not be allowed to delete a department if 
the department is currently active in the system or otherwise meets a condition that 
prevents the deletion.  If such a condition exists, you are notified by a message window. 

_____________________________________________________________________________  
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Step 2: Creating Locations 
Locations are patient rooms, operating rooms, storage rooms, or any other area that must be 
monitored or tracked in any way by SupplySource.   

Once you have added all of your locations to the database, you should assign them to Display 
Terminals.  Adding Display Terminals is explained under Creating Display Terminals on page 
17. 

 To add a new location 

1. Under the Maintenance menu, select Location. 

2. Click the Add button on the toolbar. 

3. Enter the new location number and description.   

The location number must be unique, and can include letters as well as numbers.   

You can assign many locations to the same Display Terminal.  Once a location has been 
assigned to a Display Terminal, any patients assigned to that location are shown on the 
Display Terminal that services the location. 

4. Click the Save button on the toolbar. 

 To assign (or unassign) locations to one or more Display Terminals 

If you have not yet added Display Terminals to the system, skip this section and go to Creating 
Display Terminals on page 17. 

1. Select a location from the list, then click the Display Terminals button. 

The column on the left lists all Display Terminals.  The column on the right lists the Display 
Terminals that are assigned to the location.  If the Display Terminal name is followed by 
"Default", then the location is the default location for that Display Terminal. 

2. To assign only specific Display Terminals, select each Display Terminal name from the 
column on the left, then click on the > button.  The names you selected appear in the 
location’s assigned list. 

To assign all Display Terminals to the location, click on the >> button. 
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3. To unassign specific Display Terminals, select each Display Terminal name from the 
column on the right, then click on the < button, or use the << button to unassign all. 

Note that you cannot unassign a Display Terminal from the location if it is the default 
location.  Every Display Terminal has one default location, but may have additional 
locations.  To change the default location, you must use Display Terminal Configuration (see 
page 17). 

4. Click the Save button on the toolbar. 

 To delete a location 

1. Select the location. 

2. Click the Delete button on the toolbar. 

3. You are asked to confirm the deletion.  Click the Yes button to confirm the deletion, or click 
on the No button to cancel.   

4. Click the Save button on the toolbar. 

 Note that the data is not removed from the database until you save. 

_____________________________________________________________________________  

Note: To protect the integrity of the database, you may not be allowed to delete a location if the 
location is currently active in the system or otherwise meets a condition that prevents the 
deletion.  If such a condition exists, you are notified by a message window. 

_____________________________________________________________________________  



 Control Center User’s Guide 17 

Step 3: Creating Display Terminals 
You must have Configuration access rights to add Display Terminals.  If you have not yet added 
locations to the database, you should do so before adding any Display Terminals (see Creating 
Locations on page 15). 

 To add a Display Terminal 

1. Under the Maintenance menu, select Configuration, then select Display Terminal. 

2. Click the Add button on the toolbar. 

3. Enter the following data: 

The node name is a unique name (up to 16 characters) that identifies this Display Terminal.  
This can be any valid TCP/IP node name.  Examples of valid node names are DTORROOM 
or DTEYELAB.  MedSelect encourages the use of DT as the first two letters of the node 
name.  The node name can contain a hyphen or underscore, but cannot contain spaces or 
special characters.  The node name must be unique. 

Select the department where this Display Terminal is located. 

Select the specific location for this Display Terminal.  This location becomes the default 
location, but you can assign other locations as well.  Note that if you change the default 
location, the old default location continues to be assigned to the Display Terminal as a non-
default location. 

Enter the Display Terminal’s assigned IP address, which must be provided by the hospital’s 
Information Systems personnel. 

Select a logging level.  This determines the level of detail that is recorded in the Display 
Terminal’s error log.  For details, see Display Terminal Configuration Fields on page 112. 

Check the Receipt Printer box if the Display Terminal has a receipt printer.  Some Display 
Terminals may not have a printer. 

4. Click the Save button on the toolbar. 
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 To assign (or unassign) Display Terminal to one more locations 

1. Select a Display Terminal from the list, and then click on the Display Terminals button. 

The column on the left lists all locations.  The column on the right lists the locations that are 
assigned to the Display Terminal.  One of these is identified as the default location.    (To 
quickly locate the default location, select Go To Default Location under the Data menu.) 

2. To assign only specific locations, select each location name from the column on the left, then 
click on the > button.  The names you selected appear in the Display Terminal’s assigned 
list. 

3. To assign all locations to the Display Terminal, click on the >> button. 

4. To unassign specific locations, select each location name from the column on the right, then 
click on the < button, or use the << button to unassign all locations. 

Note that you cannot unassign a location from a Display Terminal if it is the default 
location.  Every Display Terminal has one default location, but may have additional 
locations.  

5. To change the default location, select the name of the new default location you want from the 
column on the right, then choose the Set As Default Location option from the Data 
menu. 
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 To delete Display Terminals 

1. Select the Display Terminal. 

2. Click the Delete button on the toolbar. 

3. You are asked to confirm the deletion.  Click the Yes button to confirm the deletion, or click 
on the No button to cancel.   

4. Click the Save button on the toolbar. 

Note that the data is not removed from the database until you save. 

______________________________________________________________________________  

Note: To protect the integrity of the database, you may not be allowed to delete a Display 
Terminal that has dispensing devices assigned to it.  If such a condition exists, you are 
notified by a message window. 

______________________________________________________________________________  
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Step 4: Creating Cabinets 
Locations must be in the database before you can generate create cabinets.  Use Cabinet 
Configuration to add, modify, and delete the names of SupplySource Towers.   

 To add a cabinet 

1. Under the Maintenance menu, select Configuration, and then select Cabinet. 

2. Click the Add button on the toolbar. 

3. In the Cabinet Description field, enter a description for the cabinet or area, for example, 
ER Tower 1, CCU Tower 3, ICU Tower 1, or CCU Tower 6. 

4. Select a location from the drop-down list. 

5. Click the Save button on the toolbar. 



 Control Center User’s Guide 21 

Step 5: Controller Configuration 
Once you have added the cabinet name and location, you must enter the controllers contained 
within the cabinet.   

If you have the Economy model of the SupplySource tower, you should create only Electronic 
Lock controllers—0C controllers (see the next page). After those are completed, move on to Step 
6 on page 25. 
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Creating a Controller for an SST Electronic Lock 

Do the following to set up any electronic lock controller.  You only have to create one Electronic 
Lock Controller for each SST: 

1. Under the Maintenance menu, select Configuration, and then select Controller. 

2. Click the Add button on the toolbar. 

3. Enter the following data: 

Address is the number assigned to the processor chip on the controller (SST Electronic 
Lock controller names begin with 0C—zero C). 

Type Description is a description of the device, in this case SST Electronic Lock.  This 
field is filled in automatically when you tab out of the Address field. 

Display Terminal is the name assigned to the Display Terminal that powers this 
controller.  If the Display Terminal you want is not listed, then you must add it using Display 
Terminal configuration. 

Cabinet Description identifies the cabinet that contains this controller.  Choose the 
description from the drop-down list.  If the cabinet you want is not listed, you must add the 
cabinet using Cabinet configuration. 

Sequence Number is the number that describes the physical order of controllers in a 
cabinet.  An SST Tower can have only one Electronic Lock controller. This field is filled in 
automatically.   

Controller Configuration is the number sequence (1-1-1-1, 1-1-2, 1-2-1, 1-3, 2-1-1, 2-2, 
3-1) that describes the configuration of the Electronic Locks (doors) attached to the 
controller.   

4. Click the Save button on the toolbar. 
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Creating a Controller for an SST Shelf 

Controller configuration for an SST Shelf is similar to an SST Lock, but requires that you specify 
the shelf number and the way the shelf is divided.  To add a controller of this type, use SST Lock 
Controller Configuration but observe the following differences: 

1. The Address must begin with 0D (a zero and the letter D). 

2. The Sequence Number must be filled in.  The Sequence Number is the shelf’s 
position number in the cabinet, starting at the top.  The maximum number of shelves is 16.  
Tab to open the 0D Shelf Controller dialog. 

In the 0D Shelf Controller dialog, the shelf is divided into 18 shelf positions by default 
(the maximum number possible). See below for shelf configuration instructions. 

3. The Controller Configuration field defaults to 18 (the maximum number of shelf 
positions). 

4. Click the Save button on the toolbar. 

______________________________________________________________________________  

Note: Do not create 0D controllers if you are configuring an Economy Tower, create 0C 
Controllers and move on to Step 6: Adding Bins to SST Shelves (Economy model 
only) on page 25. 

______________________________________________________________________________  

 To configure a 0D shelf 

When the 0D Shelf Controller dialog opens, it defaults to the maximum number of shelf positions 
(18) and a “Pull Out” shelf type.   

To Configure a “Pull Out” Shelf: 

1. In the 0D Shelf Controller dialog, choose the Shelf Type as Pull Out. 

2. The shelf will be defaulted to the maximum number of positions (18). 

3. Click the  button to remove shelf dividers.  Note that the shelf indicator buttons on the 
Button Bar in the dialog will change accordingly. 
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4. To put a divider back, click the  button. 

5. Click OK.  

To Configure a “Fixed” Shelf: 

1. In the 0D Shelf Controller dialog, choose the Shelf Type as Fixed. 

 In addition to the  buttons, pull-down menus will appear at the bottom of each shelf 
division. 

2. First, configure the vertical dividers with the  buttons.  Then, choose the horizontal 
dividers with the pull-down menus. 

If you choose: 

1-1-1 The row will be divided in thirds. 

1-2 The row will be divided in 2—with the front section 1/3 of the row and back section 
2/3. 

2-1 The row will be divided in 2—with the front section 2/3 of the row and back section 
1/3. 

3  The row will have no horizontal dividers 

Note that the shelf indicator buttons on the Button Bar will change accordingly. 

3. Click OK.  
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Step 6: Adding Bins to SST Shelves (Economy model only) 
If you are setting up an Economy SupplySource tower, you will need to configure the Economy 
Tower Bins after you have created your cabinets (Step 4) and your SST Electronic Locks (Step 5).   

 To configure economy tower bins 

1. Under the Maintenance menu, select Configuration, and then select Economy Tower 
Bins. 

2. From the Cabinets pull down menu, choose the SST you would like to configure. 

3. From the Doors list, choose the door that contains the shelf or shelves you would like to 
configure. 

4. Click the Auto-Generate button, and specify the number of bins you need. The number of 
bins you requested will be created. 

You can also create bins by clicking on the Add button.  Each click on the Add button will 
add an additional bin. 

Bins can be deleted by using the Delete button.  Choose the bin you would like to delete and 
click the Delete button. 

5. Click the Save button on the toolbar.  
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Changing the System Configuration 
You need to reconfigure SupplySource whenever a Tower is added, removed, or replaced.  You 
may also need to edit names or make other changes that could occur when some part of the 
facility is changed or renamed.  

Removing System Components 

You can remove a SST or controller by opening a configuration window and deleting the 
component. 

Deleting SupplySource Towers 
When you delete a SupplySource Tower, all associated controllers and positions are also deleted.  
However, you cannot delete a device or area if there are supplies assigned to its positions.  
Unassign all supplies before deleting. 

 To delete a SupplySource Tower 

1. Under the Maintenance menu, select Configuration, and then select Cabinet. 

2. Select the cabinet you want to delete.   

3. Click the Delete button on the toolbar. 

You are asked to confirm the deletion.  Click the Yes button to confirm, or click on the No 
button to cancel.  You may have to confirm more than once. 
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Deleting Controllers 
Deleting a controller causes all associated positions to be deleted.  You cannot delete a controller 
if there are supplies assigned to its positions.  If you know you want to delete all of the controllers 
in a SST, it may be quicker to delete the entire cabinet, which also deletes all of its associated 
controllers.  To delete a cabinet, see Removing System Components on page 26.   

 To delete individual controllers without deleting the cabinet 

1. Under the Maintenance menu, select Configuration, and then select Controller. 

2. Select the controller you want to delete.   

3. Click the Delete button on the toolbar. 

You are asked to confirm the deletion.  Click the Yes button to confirm, or click on the No 
button to cancel.  You may have to confirm more than once. 

Deleting a Display Terminal  
You cannot delete a Display Terminal unless all of its associated controllers have been deleted.  
See Deleting Controllers above.  To delete a Display Terminal, follow these steps: 

1. Under the Maintenance menu, select Configuration, and then select Display Terminal. 

2. Select the Display Terminal you want to delete.   

3. Click the Delete button on the toolbar. 

You are asked to confirm the deletion.  Click the Yes button to confirm, or click on the No 
button to cancel.  You may have to confirm more than once. 
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Replacing System Components 

The requirements for replacing a system component vary by component.  The following 
instructions explain how to replace each SupplySource component. 

Modifying or Replacing a Controller 
The following rules apply when modifying or replacing a controller: 

1. You can swap out an old controller and replace it with a new controller only if the 
controllers are the same type.  This means that the two controllers must have the same 2-
digit prefix in their address.  For instance, you can replace a SST Lock controller with 
another Lock controller (prefix of 0C).  You can replace a SST Shelf controller with another 
Shelf controller (prefix of 0D). 

To replace a controller, you must first delete the unwanted controller, then add the new 
controller.  To delete a controller, see Deleting Controllers on page 27.  To add a controller, 
see Controller Configuration on page 21. 

2. You can replace a controller with another of the same type without unassigning supplies only 
if the new controller has the exact same configuration as the old.  When you do this, you 
change only the controller address in the database; all other information remains the same. 

3. If you want to change a controller’s configuration, you must unassign all supplies for that 
controller.  For instance, if you want to change a controller that supports a SST Shelf with 18 
compartments so that it supports a SST Shelf with 2 compartments, then you must unassign 
each of the supplies in the 18 compartments.  You can then modify the controller’s 
configuration in the database (including the address, if you want to simultaneously swap the 
controller and change the configuration). 
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 To modify or replace a same-type controller 

1. Under the Maintenance menu, select Configuration, and then select Controller. 

2. Select the controller you want to modify or replace. 

3. Under the Data menu, select Modify Controller.  A Modify Controller window opens. 

4. Change the data to match the new controller. 

If the controller has supplies assigned to it, then you are only able to edit the address of the 
controller (the 2-digit prefix cannot be edited to ensure that this controller type remains the 
same).  If not, then you can modify everything but the description, which is created 
automatically based on the prefix to the address. 

Replacing a SupplySource Tower 
To replace a SST, you must first delete the unwanted SST, then add the new one.  To delete a 
SST, see Deleting SupplySource Towers on page 26.  To add a cabinet or area, see Creating 
Cabinets on page 20. 

If a SST is being replaced with another SST and you plan to keep the old cabinet name, you 
could keep the old cabinet name in the database and change only the controllers assigned to the 
SST.    

Replacing a Display Terminal 
If a Display Terminal is replaced, the new Display Terminal should be given the same node name 
as the old Display Terminal.  If this is done, no change is needed at the Control Center.  The new 
Display Terminal should function properly.  A Display Terminal should only be replaced by 
authorized MedSelect service personnel. 
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Client Configuration 
Client Configuration is used to identify clients such as the Nursing WorkStation (NWS), 
Restocking WorkStation (RWS), etc.  These software applications are not currently components 
of the Control Center, but can be run on the same PC as the Control Center. 

You must have Configuration access rights to add clients.  If you have not yet added Departments 
to the database, you should do so before adding any clients (see Step 1: Creating Departments 
on page 14).   

 To add a client 

1. Under the Maintenance menu, select Configuration, and then select Client. 

2. Click the Add button on the toolbar. 

3. Enter data in each field on the form.  For details about the information used on this form, see 
Client Configuration Fields on page 105. 

4. Click the Save button on the toolbar. 

 

 To delete clients 

1. Select the client. 

2. Click the Delete button on the toolbar. 

You are asked to confirm the deletion.  Click the Yes button to confirm the deletion, or click 
on the No button to cancel.   

3. Click the Save button on the toolbar. 

Note that the data is not removed from the database until you save.  When you delete a 
client’s configuration, that client continues to run normally if it was already in use.  When 
that client application is closed, it is not possible to restart the client until a new 
configuration is added at the Control Center. 
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Part Two: Information Management Using the Control Center  
SupplySource administration is performed using the Control Center.  The Control Center is an 
application you can run on almost any personal computer that can run Microsoft

  Windows  95, 
98 or 2000, and is on the same network as SupplySource.  You use data entry forms to enter 
information about patients, system users, and inventory.  This information is processed and 
stored by the database server, and can be retrieved whenever you need it.  You can view or print a 
variety of reports that display the information you need to accomplish specific tasks such as 
restocking. 
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Control Center Standard Tools and Features 

Toolbar 
Depending on the window you are viewing, the Control Center toolbar may contain any of the 
following buttons: 

 

Close Closes the current 
window. 

Add Adds a new item to the list or form you 
are viewing. 

Print Prints the contents of the 
current window (report, 
browser, etc.). 

Insert Inserts a new item directly above the 
currently selected item in a list. 

Print Preview Shows a preview of a 
printout on the screen, or 
cancels print preview. 

Delete Deletes the currently selected item 
from the list you are viewing. 

Add Patient Adds a Patient (when 
viewing the Patient 
browser or Patient 
Detail). 

Sort Activates the Sort feature. 

Add Visit Adds a Visit (when 
viewing the Patient 
Detail). 

Filter Activates the Filter feature. 

Delete Patient Deletes a Patient (when 
viewing the Patient 
browser or Patient 
Detail). 

Find Activates the Find feature. 

Delete Visit Deletes a Visit (when 
viewing the Patient 
Detail). 

Save Saves the current entry. 

 Help Activates the online help. 
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Positioning the Toolbar 
You can reposition or remove the toolbar from the screen by right clicking on the buttons.  This 
opens a list box of several options.  To remove the toolbar, select Sheetbar.  The toolbar is 
removed until the next time you open a new window (by opening a browser, detail, etc.).  To 
reposition the toolbar, select Left, Top, Right, Bottom, or Floating.  If you select floating, 
the toolbar becomes its own small window. 

Identifying a Button 
When you place the pointer over a button and leave it there, a small pop-up message indicates the 
name of the button.  You can also change the button style so that the button always displays the 
name of its function.  To do this, right click on the buttons, then select Show Text. 

Radio Buttons 
Radio buttons allow you to choose an exclusive item.  They are called radio buttons because they 
work like station select buttons on a radio.  Only one can be chosen at one time.  Radio buttons 
are usually round, and the selected button contains a filled center.  The other buttons are empty. 

 

Drop-down lists 
A drop-down list is a list of valid items that may be inserted into a data field.  Drop-down lists 
usually contain information that is entered on another form.  Drop-down lists are indicated by a 
button with an arrow pointing downward. 

 

Click on this button to open the list, which appears to “drop-down” from the field.  Click on one 
of the items in the list to insert it into the field.   When a field uses a drop-down list, you can only 
insert information from the list.  You cannot type information into a field that contains a drop-
down list. 

Browsers 
A browser is a form that presents a list of names or items, usually for the purpose of performing 
some action or retrieving more detailed information on an item in the list.  Browsers such as the 
patient browser, supply browser, and user browser contain abbreviated information on patients, 
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supplies, and users, respectively.  Double-clicking on one of these items opens a detailed form 
that shows more specific information about the item you chose. 

Some browsers contain information that can be edited directly on the browser.  Other browsers 
only show information that must be added, edited, or deleted by using a detail form.  For 
instructions on using a particular browser, see the explanation of the form that contains the 
browser. 

Detail Forms 
A detail is a form that displays details about a specific item or person.  For instance, a patient 
detail shows personal details about the patient, such as address, birthdate, etc.  Detail forms are 
often accessed by choosing an abbreviated description of the displayed item on a browser. 

Required Fields 
A detail or browser often contains required fields, which are fields that must be filled in, and 
optional fields, which may be left blank but provide helpful information when used.  Required 
fields are indicated by boldface type. 

Editable and Non-editable Fields 
Any field on a detail that has a white background can be edited.  Fields with a dark background 
cannot be edited.  Non-editable fields usually contain information that is either entered by the 
system automatically or is displayed for information purposes only. 

Using the Tab key to move from one data field to the next 
When working on a detail or browser, the Tab key causes the cursor to move from one field to the 
next.  The Enter key does not perform this function. 

Printing Functions 
You can print information on browsers, details, or reports by clicking on the Print button on the 
toolbar.   

Double-clicking vs. Click/Select Button 
Any function that is performed by first selecting an item, then clicking on a button, can also be 
performed by double-clicking on the item.  For example, you can open a patient detail by 
selecting a patient from the patient browser, then clicking on the Patient Detail button.  
However, you can also double-click on the patient name in the patient browser to open the detail. 
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Check Boxes  
Check boxes indicated whether an option is selected or not.  When an option is not selected, the 
check box is empty.  When an option is selected, the box contains a checkmark. 

 

Toggling Between Open Windows within the Control Center Application 
You may want to have several windows, such as a Patient browser, Patient Detail, and Supply 
browser open all at the same time.  You can minimize one window to view others behind it, or 
you can use CTRL+TAB to move from one window to the next.  Press and hold the CTRL key 
while repeatedly pressing the TAB key to move from window to window. 

By clicking on the Window menu, you can view a list of open windows.  Click on one of the 
window names to bring that window to the foreground. 

If you need to bring up other applications (such as a word processor or spreadsheet) that are 
running on your computer behind the Control Center, you can use ALT+TAB to move from 
application to application. 

Viewing Online Help 
The Control Center includes context sensitive online help.  This means that whenever you open 
help, the topic that appears contains specific instructions on the Control Center form or window 
you were using.  The online help is always the most current source of information about the 
Control Center.  Every time the Control Center software is updated or upgraded, a new online 
help file is included.  Therefore, the online help may contain information that is not in this 
User’s Guide. 

To open help, you can click on the Help button on the Control Center toolbar.  For more 
instructions on using Windows help, consult your Microsoft Windows documentation. 
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Logging In to the Control Center 
To start the Control Center application, click on the Start button on the Windows Task Bar, 
select Programs, then select MedSelect, then select Control Center. 

The Control Center is Username and PIN protected.  You must log in using a valid Username 
and PIN provided by the system administrator.  You also must have Control Center Login access 
rights to log in to the Control Center.  All unsuccessful login attempts are recorded in the System 
Log Message report. 

Logging in After a New System Installation 
A newly installed Control Center includes a default administrative account that you can use until 
you have added a unique account for yourself.  Once you have added your own user account, you 
should delete or disable the default administrator account as described under Maintaining User 
Accounts on page 40. 

To login as the default administrator, see Login and Preparation on page 12. 

Changing Your PIN 
You can change your own PIN number after you have logged in to the Control Center.  You use 
this PIN whenever you log in to the Control Center or a Display Terminal. 

 To change your PIN 

1. Under the File menu, select Change PIN.  The Control Center PIN Change window opens. 

2. In the Current PIN field, type your current PIN. 

3. In the New PIN field, type the new number that you want to use as your PIN. 

4. In the Confirm PIN field, type your new number again to verify that you did not mistype. 

5. Click the OK button.  Your new PIN will be effective the next time you log in. 



 Control Center User’s Guide 37 

Normal Login Procedure 
Once you have started the Control Center, the login prompt appears, as shown below. 

 

 To enter your Username and PIN 

1. Type your User Name. 

2. Press the TAB key to move the cursor to the next line. 

3. Type your PIN, then press ENTER (or click OK).   

If this is the first time that you have logged into any SupplySource application, then your 
PIN is 9999.  After you enter 9999, you are prompted to change your PIN. 

A successful login allows access to all Control Center menus.  Once you have started a Control 
Center session, you cannot start another Control Center session until you close the current 
session.  Multiple Control Center sessions cannot run on the same computer at the same time. 
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Control Center Menus 
The Control Center menus organize the work that can be accomplished at the Control Center.  In 
addition to standard Windows menus, there are two Control Center menus you use to perform 
routine system administration: Management, and Maintenance. 

Management Menu 
The Management menu includes those functions typically performed on a daily basis.  Patient 
accounts, supply control, and file importing are all managed through this menu. 

Maintenance Menu 
The Maintenance menu includes those functions that are normally configured during the system 
setup, and that change little over time.  User Accounts, Facility Setup, and System Configuration 
are all maintained through this menu. 

Because the system must be set up before it can be used, the Maintenance menu is explained first. 

Knowing What Kind of Information to Enter on a Control Center Form 
Much of the information stored by SupplySource may be downloaded through a system interface, 
but all of it can be entered directly at the Control Center.  Each Control Center form has unique 
fields.  A listing of all Data Entry Fields that begins on page 103 explains these fields in detail, 
including any pre-loaded data, limited field lengths, and suggestions for entering useful 
information.   

This information is also included in the Control Center online help.  Every help topic that 
contains instructions for entering data also includes a topic that explains the data fields.  If you 
open the fields topic, you can leave it open and consult it while you work in the Control Center 
application. 

 To reference fields information in the Control Center online help 

Suppose you are working in the Supply Detail and need to know what kind of information to put 
in the data fields.  Follow these steps: 

1. Click the Help button. 

A context sensitive help topic opens.  This topic lists options related to the Supply Detail. 

2. Click on the option for Supply Detail Fields. 

A second window called Supply Detail Fields opens.   

3. Enter information in the Supply Detail while consulting the help window.   
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Using The Maintenance Menu 

The Maintenance menu provides 
most of the functions you need to set 
up the system and control data that 
does not change frequently.  User 
account maintenance, facility setup, 
and system configuration are all 
performed through this menu. 
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Maintaining User Accounts 

User accounts, including access right assignments, are managed through User Maintenance.  You 
create an account for every system user, and define access privileges depending on the user’s 
authorization to dispense materials, enter or change system data, etc.  You can also disable a user 
account temporarily, such as when a user is on vacation. 

Users must be assigned to one or more departments within your facility.  Users can only log in to 
Display Terminals that are in their assigned departments.  You can also define an expiration date 
to limit the time when a user's account is valid for a specific department. 

When you open User Maintenance, the User browser is displayed.  You can view the details of 
any user listed in the browser, add a new user, delete a user, or print user information.  If this is 
the first time that the system has been used, then the only user is the administrative account.  
Once you create a user account for yourself, you should delete the administrative account, remove 
its access rights, or change the Control Center Username or PIN so that an unauthorized person 
cannot use the account. 
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Information about users is recorded in the user detail.  The user detail is divided into two 
columns: User Information and Access Rights. 

  

Access rights can be assigned individually, or can be assigned as part of a group profile, which is 
a pre-defined group of access rights.  Access rights that are grayed out are part of a group profile. 

You must have Control Center Login and Administrate access rights to create and edit user 
accounts. 

 To view or edit the user detail 

1. Under the Maintenance menu, select User, and then select User Browser. 

2. From the User browser, click the line showing the account you want to view. 

3. Click the User Details button to open the user detail. 

4. Edit the data as necessary. 

5. Click the Save button on the toolbar. 
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 To reset a user’s Personal Identification Number (PIN) 

While viewing the user detail, click on the Reset PIN button.  This causes the user’s PIN 
number to be set to 9999.  The next time that user tries to log in to the Control Center or the 
display terminal, the user must enter 9999 as the PIN.  A prompt then forces the user to modify 
the 9999 PIN to some other number.  For security, an administrator cannot enter the user’s actual 
PIN number on the detail.  All PIN resets will be recorded in the System Log Message report. 

 To add a new user account 

1. While viewing either the user browser or user detail, click on the Add button on the toolbar. 

If you were viewing the user browser, then the user detail opens automatically. 

2. Type data into each field on the User Information column. 

You can enter all information except for the PIN number.  By default, the user’s PIN is 9999. 

3. Check off each access right you want to allow this user, or choose a profile from the Group 
Profile drop-down list. 

To clear an assigned group, select the Group Profile drop-down list, and then press the 
spacebar.  Selecting access rights and group profiles are explained in further detail under To 
select access rights on page 44.  To create group profiles, see Creating and Deleting 
Group Profiles on page 45. 

 To assign a user to one or more departments 

1. While viewing the user detail, click on the Departments button. 

The User-Department Assignment window opens.  The column on the left lists all available 
departments.  The column on the right shows departments currently assigned to the user. 

2. To assign only specific departments, select each department name from the column on the 
left, then click on the > button.  The names you selected appear in the user’s assigned list. 

3. To assign all available departments to the user, click on the >> button. 

4. To unassign specific departments, select each department from the column on the right, then 
click on the < button, or use the << button to unassign all departments. 
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5. To set an expiration date for the account, select the department from the column on the right, 
then select Change Expiration from the Data menu, and enter the date of expiration (date 
is mm/dd/yyyy; time must be military time). 

 

 To delete a user account 

______________________________________________________________________________  

Note: Instead of deleting an account, you may want to disable it.  See Disabling User 
Accounts on page 44. 

______________________________________________________________________________  

1. Select the account from the User Browser list. 

You can delete any record that is not your own.  If you must delete your own record, then you 
must first create a new record for yourself and log on with that new ID.  You can then delete 
your old record. 

2. You may choose to view the user detail, but you do not have to view the detail to delete the 
record. 

3. Click the Delete button on the toolbar. 

4. You are asked to confirm the deletion.  Click the Yes button to confirm, or click on the No 
button to cancel the deletion. 

If you performed the deletion from the user browser, then the data is not removed from the 
database until you click on the Save button on the toolbar. 

______________________________________________________________________________  

Note: To protect the integrity of the database, you may not be allowed to delete a user if the 
user information is being used by other Control Center forms or otherwise meets a 
condition that prevents the deletion.  If such a condition exists, you are notified by a 
message window. 

______________________________________________________________________________  
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 To select access rights 

To assign access rights, you may want to choose a group profile.  To clear an assigned group, 
select the Group Profile drop-down list, and then press the spacebar.   

If you do not want a pre-defined group profile, you can customize a user’s access rights by 
clearing the group profile, then clicking the check box next to each individual access right. A 
checkmark indicates that the access right is selected.  Click the box again to unselect the access 
right.   

Access rights are divided into three categories: System Rights, Display Terminal and Defined 
Class rights. 

Each access right is defined under User Detail Fields (Access Rights) on page 122. 

Disabling User Accounts 
You can disable a user account temporarily when a user is off-site, then enable it when the user 
returns.   Disabling the account prevents anyone from logging on to any SupplySource 
application with the disabled username and PIN. 

The system also disables an account automatically if someone tries to repeatedly log in with a 
valid username but invalid PIN.  The number of login tries allowed before an automatic disable is 
set in the Facility Maintenance window (see Maintaining Facility Settings on page 50). 

 To manually disable a user account 

1. Open the user detail for the account you want to disable. 

2. Select the Disable Login option. 

3. Click the Save button on the toolbar. 

The user can no longer log in to SupplySource.  To enable the account, turn off the Disable 
Login option. 

 



 Control Center User’s Guide 45 

Creating and Deleting Group Profiles 
You can create group profiles that include specific access rights, instead of individually assigning 
rights to each user.  You can give a group profile any description you wish, and it can include 
any access rights you want.  

For instance, suppose that you want to assign all Registered Nurses one set of rights, and all 
Licensed Practical Nurses to have another set.  You might create one group called RN, and 
another called LPN.  To each of these profile groups, you would assign all of the rights you want 
the group to have.  Then, you would assign each nurse to the appropriate group.  If you later 
change the rights of the RN group, every user with RN profile group rights would be affected by 
the change. 

Once you have assigned a group profile to a user, you can still add or delete additional individual 
access rights but you cannot modify rights that are part of the profile. 

For more information on assigning users to profile groups, see To select access rights on page 
44. 

 To view or edit group profiles 

1. Under the Maintenance menu, select User, and then select Group Profile. 

2. Click on the description of the group profile you want to view. 

3. Select or unselect any access rights to modify the profile, as you want. 

4. Click the Save button on the toolbar. 

 To create a group profile 

1. Under the Maintenance menu, select User, and then select Group Profile. 

2. Click the Add button on the toolbar. 

3. Type a new group profile description. 

You can use single quotes in the description, but not double quotes. 

4. Select each access right you want to associate with the profile. 



Control Center User’s Guide  46

Access rights are divided into three categories: System rights, Display Terminal rights, and 
Customer Defined Class rights (see page 47).  Click on the System, Display Terminal, or 
Defined Class index tabs to view the associated rights. 

5. Click the Save button on the toolbar. 

 

 To delete a group profile 

1. On the Group Profile detail, select the profile you want to delete. 
2. Click the Delete button on the toolbar. 

A confirmation box asks you to confirm the deletion.  Click the Yes button to confirm. 

_____________________________________________________________________________  

Note: To protect the integrity of the database, you are not allowed to delete a group profile if 
the profile is assigned to any users.  You must remove the assignment from all users 
before you can delete a group profile.  If such a condition exists, you are notified by a 
message window. 

_____________________________________________________________________________  
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Customer Defined Classes 
Customer Defined Classes (CDCs) allow you to create your own classes of supplies. These classes 
can then be used to grant restocking and/or dispensing privileges to individual users or user 
groups. 

You need the Administrate access right to create Customer Defined Classes. 

 To Create a Customer Defined Class: 

1. Under the Maintenance menu, select Customer Defined Class. The Customer Defined 
Class window will open. 

2. Click the Insert button on the toolbar.  

3. Enter a description for your Customer Defined Class (maximum of 15 characters). 

4. Click the Save button. 

5. When a new CDC is saved, two corresponding access rights are created—one for restocking 
and one for dispensing. These access rights may then be assigned in the User Detail or the 
Group Profile Maintenance windows, Access Rights area, Defined Class index tab.  

 

 To Assign Supplies to a Customer Defined Class: 

1. Under the Maintenance menu, select Customer Defined Class. The Customer Defined 
Class window will open. 

2. Choose the CDC Description to which you would like to assign supplies. 

3. Click the Supplies button. 
The CDC Assignment window will open. The supplies without a defined class will appear on 
the left, the supplies already assigned to this CDC will appear on the right. 

4. Assign/unassign supplies to this CDC via drag and drop, or by using the arrow buttons. 

5. Click the Save button. 

6. A supply’s CDC can be found in the Supply Assignment window (From the Management 
menu, choose Supply Assignment) or in the Supply Browser (Management, Supply). 
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 To Assign Individual Supplies to a Customer Defined Class: 

1. From the Management menu, choose Supply. Highlight the supply you’d like to assign a 
CDC and click the Supply Details button. Choose the CDC you want to assign this supply 
from the pull down list in the Customer Defined Class field. (See page 47.)  

2. Click the Save button. 

A supply’s CDC can be found in the Supply Assignment window (From the Management 
menu, choose Supply Assignment) or in the Supply Browser (Management, Supply). 
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Facility Areas: Departments, Locations, and System-wide Attributes 
Locations and departments are created and configured when SupplySource is installed.  For a 
complete explanation of these terms, and instructions on configuring the system, see Part One: 
System Configuration at Installation on page 11.  If you must add to or modify your existing 
system, consult Part One. 

If you want to edit location or department information without changing the configuration, then 
use the following instructions. 
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Maintaining Facility Settings 

Facility Maintenance is used to define global settings for SupplySource.  The attributes you 
choose affect all devices in the system, regardless of department.  To define specific department 
settings, see Maintaining Department Settings on page 52. 

 

Facility Maintenance is used to define the following system attributes: 

# Login Tries  (required) The number of times a user can unsuccessfully attempt to log in 
to a SupplySource software application before that user’s account 
is disabled.  An unsuccessful log in means that the user entered 
the correct login ID but an incorrect PIN. 

DT Find Closed Visit If checked, indicates that a patient find performed at a Display 
Terminal should search for closed as well as open visit records. 

Positive Identification 
Login Required 

If checked, indicates that all users in your facility must use a 
swipe card to log in to the Display Terminal.  Logging on by 
manually entering a Login ID is not permitted.  The user is 
required to enter a unique PIN number in addition to using the 
swipe card. 
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 To view or edit facility data 

1. Under the Maintenance menu, select Facility. 

2. Edit any data as necessary. 

3. Click the Save button on the toolbar. 
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Maintaining Department Settings 

Department Maintenance is used to create different departments within your facility, and then to 
define settings specific to the Display Terminals in each department.  Each department may have 
unique settings. 

In addition to department settings, there are global system settings that can be defined using 
Facility Maintenance.  These are described on under Maintaining Facility Settings on page 50. 

When you have created departments and defined their attributes, you can assign users to those 
departments.  Users may only log in to Display Terminals that are in their assigned departments. 
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Department Maintenance is used to define the following attributes: 

Department Options 
These are options and attributes you can define at a department level: 

Department (required)  A name you create to identify a department. 

DT Timeout  (required) The length of time, in seconds, that a Display Terminal can be 
idle before automatically logging out the user. 

DT Restock Timeout 
(required) 

The length of time, in seconds, that a Display Terminal can be 
idle during a restock before automatically logging out the user.  
This is usually longer than the regular DT Timeout. 

DT Patient Usage (required) Indicates how many past hours’ worth of time the Display 
Terminal should use to show patient usage information.  For 
instance, a value of 48 indicates that the Patient Usage window 
shows all patient usage for the past 2 days.  The default is 72 
hours. 

ID Card  Lead Digits and 
Trail Digits 

These values determine how a user’s ID string is read from a 
swipe card. 

Lead digits indicate how many numeric characters should be 
ignored at the beginning of the string.  Alpha characters are 
automatically ignored.  For instance, if the lead string is A000, 
then Lead Digits should be set to 3 (because the "A" is 
ignored.). 

Trail digits indicates how many numeric characters to ignore 
at the end of the string but prior to the = sign.  Every character 
after the = sign is ignored.  All alpha characters in the trailing 
digits are also ignored.  For instances, if the string ends with 
0A00=0B and the Trail Digits is set to 3, then the 0A00 is 
ignored.  The 0B is also ignored because it appears after  
the = sign. 
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Display Terminal Options 
You can define these attributes for all Display Terminals within a department: 

PIN Required If checked, indicates that user must enter a PIN number to 
login to DT. This is not checked by default. 

Find Patient by ID  If checked, indicates that when a user performs a patient find 
at a Display Terminal, the patient ID field is an option for 
specifying find data.  Otherwise, the patient ID field is not an 
option for a patient find. 

Not Available for Find/Add If checked, indicates that patients in this department cannot be 
"found" by other departments when they do a patient search.  
The patient can still be found if searched for within its own 
department. 
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Display Terminal Sorting 
These are default sorting options that can be set for every Display Terminal in a department: 

Supply Name Allows you to select the default display format for supplies 
listed on the Supply browser.  You can choose to show 
supplies by their material name or nursing name. 

Patient Browser Allows you to select the default sort order for patient records 
listed on the Patient browser.  You can choose to display 
records alphabetically in order by patient name or the room 
description. 

StockIt Window Allows you to select the default sort order for supplies listed on 
the StockIt window.  You can choose to display supplies 
alphabetically in order by their position or the supply name. 

Usage Browser Allows you to select the default sort order for transactions 
listed in the Usage browser, which shows all supply 
transactions for a particular patient.  You can choose to list the 
transactions in order chronologically by the date of the event, 
or alphabetically by the name of the supply involved. 
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 To view or edit department data 

1. Under the Maintenance menu, select Department. 

2. Edit any data as necessary. 

3. Click the Save button on the toolbar. 

 To assign (or unassign) a department to one or more users 

1. While viewing the Department Maintenance window, select a department, and then click on 
the Users button. 

The Department-User Assignment window opens.  The column on the left lists all user 
names.  The column on the right shows users currently assigned to the department. 

2. To assign only specific users, select each user name from the column on the left, then click 
on the > button.  The names you selected appear in the department’s assigned list. 

3. To assign all users to the department, click on the >> button. 

4. To unassign specific users, select each user name from the column on the right, then click on 
the < button, or use the << button to unassign all users. 

5. To set an expiration date for the account, select the user name from the column on the right, 
then select Change Expiration from the Data menu, and enter the date of expiration (date 
is mm/dd/yyyy; time must be military time). 
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Maintaining Locations 

All rooms in your facility are recognized by their location name.  You can use Location 
Maintenance to enter all location names, such as patient rooms, operating rooms, hallways, and 
storage rooms.  These names are used to identify the areas that contain all SupplySource devices, 
the inventory that is tracked by the system, and all patient care areas. 

After you have added locations, you can assign them to Display Terminals (Configuration access 
rights are required to do this).  When you assign a location to a Display Terminal, the Display 
Terminal only displays records for patients who are also assigned to that same location.  
However, a user at a Display Terminal can find a patient in any location by using the Display 
Terminal’s Find/Add feature (see the SupplySource Display Terminal Dispensing Guide).   

 

 To view or edit locations 

1. Under the Maintenance menu, select Location. 

2. Edit any information as necessary. 

3. Click the Save button on the toolbar. 
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 To add locations 

1. Click the Add button on the toolbar. 

2. Enter the Location Number (required) and the Location Description (optional). 

The Location Number must be unique, and can include letters as well as numbers up to 15 
characters.  You cannot use double quotes in the location number. 

The Location Description is not shown on any reports or data screens.  It is only provided 
on this window for additional information to help you identify a location.  SupplySource uses 
the Location Number when referencing a location on any report or data window. 

 To add a range of sequential locations 

1. Under the Data menu, select Add Range. 

2. Type the name of the lowest room number in the Beginning Location Number field, and 
the highest room number in the Ending Location Number field. 

You can type any combination of numbers and letters.  The automatic sequencing is based on 
the first string of unrepeated numbers found in your entry.  For instance, if you enter 
Room50-1B as the beginning number and Room50-12B as the ending number, the system 
bases its sequencing on the numbers 1 through 12, ignoring everything to right and left of 1 
and 12.  After Room50-1B, the first location generated would be Room50-2B, followed by 
Room50-3B, and so on.   If you started with a location of 200West and ended with 210West, 
the first location generated after 200West would be 201West, then 202West, and so on.   

The system can add leading zeros to make your start number and end number consistent.  
For instance, if your start number is Room001 and your end number is Room10, the system 
can change the end number to Room 010 so that the leading zeros are matched.   

3. To cause the generation to skip every other number, check the Skip Every Other Number 
option. 

This allows you to generate only odd or even numbers, if necessary. 
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4. Specify how you want the locations to be described.   

You can select Use This Description For All, and then type a description, to give the 
same description to all of the new locations.   If you select Description Same As 
Number, the description is identical to the number for each location. 

5. Click the OK button when you are ready to generate the new locations. 

If your locations include leading zeros, then you are asked whether you want to use the zeros.  
If you respond No, then the zeros are dropped from the location number.  For instance, 
Room01 becomes Room1. 

 To delete a location 

1. Select the location. 

2. Click the Delete button on the toolbar.   

You are asked to confirm the deletion.  Click the Yes button to confirm, or click on the No 
button to cancel the deletion.   

3. Click the Save button on the toolbar.  Note that the data is not removed from the database 
until you save. 

______________________________________________________________________________  

Note: To protect the integrity of the database, you may not be allowed to delete a location if the 
location information is being used by other Control Center forms or otherwise meets a 
condition that prevents the deletion.  If such a condition exists, you are notified by a 
message window. 

______________________________________________________________________________  
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 To assign (or unassign) a location to one or more Display Terminals 

1. Select a location from the list, and then click on the Display Terminals button. 

The column on the left lists all system Display Terminals.  The column on the right lists the 
Display Terminals that are assigned to the location. 

2. To assign only specific Display Terminals, select each Display Terminal name from the 
column on the left, then click on the > button.  The names you selected appear in the 
location’s assigned list. 

3. To assign all Display Terminals to the location, click on the >> button. 

4. To unassign specific Display Terminals, select each Display Terminal name from the 
column on the right, then click on the < button, or use the << button to unassign all Display 
Terminals. 

Note that you cannot unassign a Display Terminal from a location that is the default location 
for the terminal.  Every Display Terminal has one default location, but may have additional 
locations.  The default location can only be modified in Display Terminal Configuration (see 
Creating Display Terminals on page 17). 
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Restock Amounts 
The Restock Amounts window updates the database for Examiner Refill reports.  If you have a 
daily automated task updating the database at a preset time, this function should only be used if 
you want to do an interim restock. 

The Restock access right is required for this function. 

 To calculate Restock Amounts: 

1. Under the Maintenance menu, choose Restock Amounts.  

2. Choose the Location you would like to restock (the Display Terminal name(s) and 
Department name for that location are also listed).  

3. Choose the Report type—Below Min or All Positions.  

4. Click the Calculate button.  Before it prints, a message box will remind you how many 
cabinets are at that location.  Click OK. This will update the database. 

5. Open Examiner and print the appropriate Refill Positions report.  See Generating Reports: 
Using Examiner on page 92.  
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Using the Management Menu 

The Management menu provides most of the 
functions you need to manage the daily flow of 
information.  Patient accounts, supply 
assignment, and file importing are all 
managed through this menu. 
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Managing Patient Records 

Patient data is added, edited, and deleted by using Patient Management.  When you open Patient 
Management, the patient browser is displayed.  You can view the details of any patient listed in 
the browser, add a new patient, delete a patient, or print patient records. 

The patient detail provides two different types of information about the patient: demographic 
information (which includes personal information and current visit information), and supply 
usage information.   

The information under the Demographics tab is the only information you can add or edit.  The 
information under the Usage tab cannot be edited.   It is provided for reference only.  When you 
view usage information, the data will pertain to the visit that is currently displayed. 

The Demographics tab is divided into two parts: personal information is on the top, and 
current (open or on-hold) visit information is on the bottom.   

 

In the database, the personal information record and visit records are separate records.  Personal 
information about a patient generally changes infrequently.  Personal information can be edited, 
for instance, if the patient’s address changes.  You should never create more than one patient 
information record for the same patient.  Instead, the patient receives a new visit record for 
each new visit to the facility.   
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The total number of visits for this patient is shown in the lower right hand corner of the window.  
A patient can have an unlimited number of visits, but only one visit can have an open or on-hold 
status.  The other visits must have a closed status.  An open visit means that the Visit Status field 
reads Open.   When a patient has an open visit, that patient is displayed for selection at a 
Display Terminal in the location that matches the visit’s assigned location (on-hold visits are not 
available at the Display Terminal).  Therefore, only patients with open visits can receive charges 
for dispensed items.  Closing a visit causes the patient to be removed from the Display Terminal.   

You must have Control Center Login and Patient Management access rights to add, edit, or 
delete patient and visit records. 

 To view or edit the patient detail 

1. Under the Management menu, select Patient. 

The patient browser opens.  The patient browser lists only patients with an open or on-hold 
visit record.  The browser can be updated at any time to show new records that may be 
coming in to the database through a system interface.  To ensure that the data in the patient 
browser is current, open the Data menu, then choose the Refresh Browser option.  If you 
do not see the patient record you want, then that patient may not have any open or on-hold 
visits (see Retrieving a Patient with No Open or On-hold Visits on page 67). 

2. From the patient browser, click on the line showing the record you want to view. 

3. Click the Patient Details button (or double-click on the line showing the patient) to open 
the patient detail.  The current visit for that patient is displayed.   
 
The current visit number for each patient is displayed in the bottom right-hand corner of the 
window. To view the patient’s previous visits, from the Data menu, select Previous Visit.  
You may update the information in previous visits. 
 
Please note: as you scroll through a patient’s visit records, the Usage tab will pertain to the 
currently displayed visit. 

4. Edit the data as necessary. 

5. Click the Save button on the toolbar. 
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 To add a new patient and visit record 

1. Click the Add Patient button on the toolbar. 

2. Type data in each field on the form. 

3. Click the Save button on the toolbar. 

 To delete a patient record 

1. Select the patient name from the browser list. 

You are not permitted to delete a patient record if there is an open visit for that patient.  To 
close a visit without viewing the patient detail, from the Data menu, choose Close Visit.  
You can also view the patient detail and change the visit status to closed.  

2. Click the Delete Patient button on the toolbar. 

3. You are asked to confirm the deletion.  Click the Yes button to confirm, or click on the No 
button to cancel the deletion.   

If you performed the deletion from the patient browser, then the data is not removed from the 
database until you click on the Save button on the toolbar. 

If you were viewing the patient detail, you are returned to the patient browser automatically. 

Deleting a patient record causes all associated visits to be deleted. 

______________________________________________________________________________  

Note: To protect the integrity of the database, you are not allowed to delete a patient if the 
patient record has had supply transactions (events).  If such a condition exists, you are 
notified by a message window. 

______________________________________________________________________________  
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Closing Old Visits and Creating Additional Visits for Existing Patients 
Each patient record can have many associated visit records.  Never create more than one patient 
record for the same patient.  Always create a new visit record for each new hospital visit. 

A patient cannot have more than one open visit.  To close a visit, from the Data menu, choose 
Close Visit, or view the patient’s detail and change the Status on the visit record to Closed.  
Only open visits are displayed at Display Terminals. 

 To add a new visit  

1. Select the patient name from the browser list, and then click on the Patient Detail button to 
display the patient detail. 

If the patient already has an existing visit, you must close it before adding a new one. 

2. Click the Add Visit button on the toolbar.  A new visit opens. 

3. Enter the visit data.   

The visit number must be unique. 

4. Click the Save button on the toolbar. 

 To delete a visit 

1. Select the patient name from the browser list, and then click on Patient Detail to display 
the patient detail. 

2. If the visit you want to delete is open, you must close it before deleting. 

3. Click the Delete Visit button on the toolbar. 

You are asked to confirm the deletion.  Click the Yes button to confirm, or click on the No 
button to cancel the deletion. 

4. Click the Save button on the toolbar. 
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 To scroll through multiple visit records 

When a patient has multiple visit records, you can move to the next visit by pressing CTRL+N, 
or to the previous visit by pressing CTRL+R.  You can also choose from the Data menu 
Previous Visit or Next Visit. 

Retrieving a Patient with No Open or On-hold Visits 
If all of a patient’s visits have been closed, than that patient is no longer listed on the Control 
Center patient browser.  However, you can still retrieve the Patient’s record if you wish, then re-
open a visit or add a new visit. 

 To retrieve the patient record 

1. While viewing the patient browser, open the Data menu, and then select Locate Patient 
Without Open Visit. 

2. In the Locate window, choose the search criteria from the drop-down list in the Search 
column.   

You can search by Admission Date, Patient ID Number, or Patient Last Name. 

3. Choose an operator ( = or begins with), then type the value you want to search for in the 
Value field (the search is not case sensitive when using the last name). 

4. Click the Search button. 

All records matching your criteria are displayed in the results window.  If no records are 
found, you can click on the Reset button to clear the criteria and try again. 

5. Select the record or records you want from the results window, then click on the Select 
button.  You can also double-click on a record or records to select them. 

The patient record is displayed in the patient browser. 

Once the record has been retrieved, you can view the record and re-open a visit or add a new 
visit.  Otherwise, all visits remain closed, and the next time you open the Patient browser, this 
record is not displayed.  If a patient has no open or on-hold visits, then that patient record will 
not continue to be displayed on the patient browser after the browser is closed. 
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Assigning Unknown Supply Transactions to a Specific Patient 

When a supply transaction cannot be attributed to a patient, it is given a status of "Unknown".  
You can use Inventory Adjustment to assign an unknown transaction to the correct patient.  
When the unknown transaction is transferred, the "Unknown" description is removed. 

 To assign an unknown transaction to the correct patient 

1. Under the Management menu, select Inventory Adjustment. 

The Inventory Adjustment window displays two browsers.  The top browser shows unknown 
supply transactions, with the most recent at the top of the list.  The bottom browser is a list 
of patients. 

2. In the top browser, select the unknown supply transaction you want to transfer.   

3. In the bottom browser, select the patient who actually received the supply, then click on the 
Retrieve Inventory button. 

The patient’s name is shown in the display box above the browser, and the usage record is 
displayed where the browser used to be. 

4. Click the Move button. 

You can also drag and drop the unknown supply transaction into the patient’s usage record.   

If the transaction you want to move is a Return event, then the patient must already have a 
Taken event for that same supply (otherwise, you would be indicating a return for a supply 
that was never dispensed for the patient).  When you move a Return event, a window opens 
for you to select the Taken event that should be associated with it.  Choose the appropriate 
Taken event then click on the Select Event button. 

5. To select another patient and repeat this process, click on the Select Patient button. 
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Adjusting and Merging Patient Records 

You can use Account Adjustment to transfer dispensing transactions from one patient to another, 
or to completely merge two patient records.  You must have Account Adjustment rights to 
perform account adjustments.  

 

Transferring Supplies from One Patient to Another (Move Usage)  
When a supply is taken or dispensed, it is attributed to the patient that was selected at the Display 
Terminal.  You can use the Account Adjustment window to transfer supply events from one 
patient to another, in the instance that a supply was attributed to the wrong patient. 
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The following rules apply when you move usage: 

• You can only transfer events with a status of Taken or Taken Transfer In.   

• If a supply was taken and then returned, and you transfer the Taken event to another 
account, the corresponding Return event is transferred also.   

• If you transfer a Taken event that has a corresponding Resolved Transfer In or Resolved 
Transfer Out event, the Resolved event is not transferred, but the quantity of the Taken 
Transfer In event is updated to reflect the adjustment. 

Event statuses are defined under Identifying Adjusted Events on page 73. 

 To move supply usage: 

1. Under the Management menu, select Patient. 

2. Select the patient account that contains the supplies you want to move. 

3. Click the Patient Details button. 

4. Click the Account Adjustment button. 

5. In the bottom browser, choose the patient then visit number you want to move the supply to. 

6. Choose the supply you want to move in the top browser, then click the Move Usage button. 
You can also drag and drop supplies from the top to the bottom browser. The supply will be 
removed from the account of Patient "A" (top browser) and moved to the account of Patient 
"B" (bottom browser). 

Merging Visit Records for the Same Patient (Visit Merge)  
In the event that a patient has two visit records, one closed and one open, you can use Account 
Adjustment to merge the two visits. This might occur if a patient is admitted in the emergency 
room, and his record is closed. Then, a new record is opened when he is admitted to a room. 
These two visits should really be one continuous open visit.   

If you intend to merge Visit "A" into Visit "B", note that all supply transactions from Visit "A" 
will become the property of Visit "B".  ALL INFORMATION ABOUT VISIT "A" WILL THEN 
BE DELETED.   
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 To merge visit records: 

1. Under the Management menu, select Patient. 

2. Select the patient account that contains the visit you want to merge into the desired or 
another visit (from the same patient). 

3. Click the Patient Details button. 

4. Click the Account Adjustment button. 

 The Account Adjustment window displays two browsers. The top browser shows, in reverse 
chronological order, any supplies used by the selected patient for that visit. This is the 
sending account. The bottom form shows a patient browser. The visit you select will be the 
receiving visit. 

5. In the bottom browser, choose the same patient account that was selected above and then 
select the visit number you want to merge the top browser information (visit) with. 

6. Click the Visit Merge button. The visit shown in the top browser will be merged into the 
visit shown in the bottom browser. The visit shown in the top browser will then be deleted.  
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Merging Two Patient Records (Patient Merge)  
In the event that two records exist for the same patient, you can use Account Adjustment to 
merge them into a single record.  This might occur if a patient is entered at the Display Terminal 
without a patient ID, or if one of the records contained erroneous information (such as an 
incorrect ID) that prevented the Control Center or system interface from recognizing a duplicate 
record.  In some cases, the interface with a hospital information system may allow a patient to 
have more than one patient record. 

If you intend to merge a record for Patient "A" into the record for Patient "B", note that all supply 
transactions from Patient "A" become the property of Patient "B", including all open and closed 
visit records.  ALL INFORMATION ABOUT PATIENT "A" IS THEN DELETED.   

 To merge a patient account 

1. Under the Management menu, select Patient. 

2. Select the patient account you want to merge into another patient account. 

3. Click the Patient Details button. The current visit for that patient will appear on the screen 
(the visit number is noted in the lower right corner). 

4. Click the Account Adjustment button. 

 The Account Adjustment window displays two browsers. The top browser shows, in reverse 
chronological order, any supplies used by the selected patient for that visit. This is the 
sending account. The bottom form shows a patient browser. The patient you select there will 
be the receiving account. 

5. In the bottom browser, visits for the patient whose account needs to be merged into will be 
displayed.  

6. Click the Patient Merge button. The patient shown in the top browser will be merged into 
the patient shown in the bottom browser. The patient shown in the top browser will then be 
deleted.  All other visits (if any) for the top patient will be moved to the receiving patient 
(the bottom browser). 
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Identifying Adjusted Events 
When an event is transferred from one account to another, its status description changes, and the 
date of the event is set to today’s date. The new description indicates that the event was 
transferred manually. In addition, the sending account will receive a new event, called a Transfer 
Out event, that is used to credit the account for each event originally attributed to it. 

To save space at the Display Terminal, the abbreviation xfer is used for Transfer. 

Event Name on the Account 
Sending the Event, Before 

Adjustment 

Event Name on the Account 
Sending the Event, After 

Adjustment 

New Event on the Account 
Receiving the Event, After 

Adjustment 

Taken Taken Xfer Out Taken Xfer In 

Returned Returned Xfer Out Returned Xfer In 

Taken Xfer In Taken Xfer Out Taken Xfer In 

Resolved Credit 
Resolved Charge 
Taken (canceled) 

Cannot be Transferred 
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Managing Supplies 

Supply data is added, edited, and deleted by using Supply Management.  When you open Supply 
Management, the supply browser is displayed.  You can view the details of any record listed in 
the browser, add a new record, delete a record, or print records. 

In the supply browser, supply data that is accented by bold type indicates that the supply has 
fallen below the minimum system-wide quantity.  You can view supply quantities and other data 
on the supply detail.  To ensure that the data in the supply browser is current, open the Data 
menu, then select the Refresh Browser option. 

 

You must have Control Center and Inventory access rights to use Supply Management. 
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 To view or edit the supply detail 

1. Under the Management menu, select Supply. 

2. From the supply browser, click on the line showing the record you want to view. 

3. Click the Supply Details button to open the supply detail (or double-click on the line 
showing the supply you want to view). 

4. Edit the data as necessary. 

5. Click the Save button on the toolbar. 

 To add a new supply 

1. Click the Add button on the toolbar.  A blank Supply form opens. 

2. Enter the Supply Data.  Data fields are defined under Data Entry Fields on page 103 and in 
the online help. 

 To delete a supply  

1. Select the supply name from the browser list. 

2. You may choose to view the supply detail, but you do not have to view the detail to delete the 
record. 

3. Click the Delete button on the toolbar. 

4. You are asked to confirm the deletion.  Click the Yes button to confirm, or click on the No 
button to cancel the deletion. 

If you performed the deletion from the supply browser, then the data is not removed from the 
database until you click on the Save button on the toolbar. 

______________________________________________________________________________  

Note: To protect the integrity of the database, you may not be allowed to delete a supply if the 
supply information is being used by other Control Center forms or otherwise meets a 
condition that prevents the deletion.  If such a condition exists, you are notified by a 
message window. 

______________________________________________________________________________  
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Assigning Supplies to SupplySource 

Supplies are assigned to SupplySource positions by using Supply Assignment.  When a supply is 
assigned to a position, you may set maximum and minimum quantities for the position.  All other 
information about a supply is entered using Supply Management. 

 

You must have Control Center and inventory rights to assign supplies to SupplySource positions. 

The Importance of Setting Maximum and Minimum Quantities 
The maximum quantity is the highest quantity of the supply that should be stocked at the 
position.  For supplies that are used frequently, you may want to set the maximum quantity as 
high as the position’s holding capacity.  For supplies that are used infrequently, you may want to 
set the maximum quantity at less than the actual holding capacity, to prevent over-stocking of the 
supply. 

The minimum quantity is the lowest quantity of the supply that should be stocked at that position.  
Minimum quantities help you ensure that adequate supplies are kept in stock. 

If the same supply is stored in multiple positions, then the minimum quantity for each position 
should be set to 1.  If the minimum quantity is set higher than 1, then a position that falls below 
minimum is likely to be restocked before the inventory can roll over to the next available position 
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containing the same supply.  This causes the inventory in the second position to grow old and 
possibly expire before it can be used.  

If the minimum is set to 0, then supply position will never be listed on a below minimum report, 
because the inventory cannot fall below 0.  This may cause a position to remain empty for some 
time.   

 To assign a supply to a position 

1. Under the Management menu, select Supply Assignment. 

Supply Assignment contains two browsers.  The top is a supply browser.  The bottom is a 
cabinet browser that shows all of the supplies contained within the selected cabinet. 

2. In the drop-down Cabinet field, select a cabinet. 

3. Click on a specific position in the cabinet. 

You may have to scroll through the list of positions to locate the position you want.  A 
pointing hand (F) indicates the currently selected position. 

4. In the supply browser, select the supply you want to assign to the position. 

5. Click the Assign button. 

You can also drag and drop the supply into the cabinet browser.  

6. In the Min field, enter the minimum quantity of the supply that should be kept at this 
position.  In the Max field, enter the maximum quantity of the supply that should be kept at 
this position.  These fields are required. 

The Qty field, which shows the actual quantity currently stocked, cannot be edited from this 
form.  Actual quantities can only be entered at the Display Terminal. 

7. If you are tracking supply expirations, then enter the expiration date and manufacturer’s lot 
number of the supply with the earliest expiration date.   

Normally, this information is entered at the Display Terminal when the supply is stocked.  If 
you are not tracking the expiration, then the Expiration Date field should display 
00/00/0000 and the Lot # field should be blank.  To reset an existing expiration date, 
double-click on the date so that it becomes highlighted, then press the spacebar. 
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 To edit a position’s contents 

1. In the drop-down Cabinet field, select the cabinet that contains positions you want to edit. 

2. Click on the position you want to edit. 

3. To change the maximum or minimum quantities, click into either field, and then enter the 
new quantity. 

4. To remove or unassign the supply, check that its actual quantity is 0 (zero), then click on the 
Unassign button. 

If the position still contains supplies, then those supplies must be accounted for before you 
can unassign the supply.  Therefore, the system automatically attempts to unload any 
supplies still in the position (you must physically remove the supplies yourself).  You are 
asked if you want to unload these supplies before continuing.  If you do not, then the supply 
cannot be unassigned. 

 To check the details of a supply in the browser list or cabinet positions 

1. Right-click on the name of a supply listed in the browser or displayed in the cabinet position.  
An options list opens.  You can also open the options list by pressing the Enter key while 
the cursor is in the supply list browser box. 

2. Click the Details option. 

A supply detail opens and displays information about the supply.  These details are for 
information only.  You cannot edit the supply detail from this window.  To close the Supply 
detail and return to Supply Assignment, click on the Close button on the toolbar. 
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 To use the keyboard to move between the supply browser (top of form) and supply position 
list (bottom of form) 

1. When the cursor or selected field is in the supply browser (top of form), press CTRL+B to 
move into the supply position list (bottom of form). 

2. When the cursor or selected field is in the supply position list (bottom of form), press 
CTRL+S to move into the supply browser (top of form). 
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Discrepancy Resolution 

Discrepancies can be created at the DT in two ways: 

1. A discrepancy may be created automatically when dispensing supplies. When taking 
(dispensing) supplies, if the user “takes” more than the system thinks is available and 
enters that number on the button bar, a discrepancy is automatically created.  The user is 
asked to verify the number entered at the button bar before the discrepancy is recorded 
(to avoid creating discrepancies due to typographical errors). The event that is generated 
when the discrepancy is recorded can be viewed on the Control Center Discrepancy 
Resolution form. An administrator should correct the count at the DT after the 
discrepancy is resolved. 

2. A discrepancy may be reported during supply restocking.  If a restocker discovers a 
difference between the system count and the physical count of a supply, the restocker 
should press the Discrepancy button at the DT while viewing the discrepant position's 
Stock Amount window (if in Restock mode) or StockIt window (if in StockIt mode).  
The user is then prompted to enter the actual quantity in the position prior to restocking 
it, and a new Resolved event is generated based on the user's correction.  The position 
quantity is updated to match the user’s count, and the system count is updated 
accordingly. 

To view, print out, and resolve these discrepancies, see Viewing and Resolving Discrepancies 
(below).   



 Control Center User’s Guide 81 

Viewing and Resolving Discrepancies 
You can view and resolve discrepancies on the Discrepancy Resolution window.  This window 
lists all discrepancies that have occurred during a time period that you define.  It also shows 
detailed data related to the discrepant event. 

Unresolved discrepancies are also listed on the Discrepancy report (see Using the Discrepancy 
Report on page 84).  Once an event has been marked as resolved at the Control Center, it is no 
longer displayed on the Discrepancy report, but it may still be printed from the Discrepancy 
Resolution window. 

You can use this window to limit the information displayed and printed to make it more 
manageable.  There are two types of information you can limit: 

Date Range: When you first open the Discrepancy Resolution window, you are prompted 
to set a date range.  The number of days you specify determines how far 
back in time the browser goes to retrieve and display discrepant events. 

Previous Accesses: For each individual discrepancy listed in the browser, you may view a list of 
users who accessed the position prior to the discrepancy.  You can limit the 
number of previous accesses shown for each discrepancy.  
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 To view and comment on discrepant events 

1. Under the Management menu, select Discrepancy Resolution. 

The top form is an event browser that lists discrepant counts that have been reported at the 
Display Terminal.  Note that the Resolved column indicates whether or not the event has 
been resolved.  The bottom form is a discrepant event detail that shows information about the 
discrepancy. 

2. Click on a discrepant event. 

The specifics of the event are shown in the detail. 

3. Edit or add the resolution description as necessary. 

You can enter any text you like into the description.  You may want to explain why there was 
a discrepancy, or other similar information.  When you save the record, your name is 
appended as a signature to this description. 

4. Check off the Resolved box to indicate that this discrepant event has been reviewed and 
has been resolved. 

When this box is checked off, the discrepant event no longer appears on the Discrepancy 
report.  The event continues to be shown on the Discrepancy Resolution window on the 
Control Center; it is not purged. 

 To set the date range for the discrepancies you are viewing 

1. While viewing the Discrepancy Resolution window, from the Data menu, select Set Date 
Range. 

2. Enter the beginning and end dates to define the range you want to view. 

If you check the Always Display Before Retrieving option, you are prompted to set the 
date range every time you open the Discrepancy Resolution window in the future. 

3. If you select the Defaults button, the dates are set automatically so that the begin date is 
determined by the Report Criteria setting in the Application Properties dialog 
(Maintenance, Configuration, Client, Properties button).  The end date is today’s 
date. 
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 To view previous accesses to a discrepant position 

1. Select a discrepant event in the browser. 

2. Click the Show Previous Access button.  

You can also double-click on the discrepancy, or select from the Data menu Show 
Previous Accesses.  

A new window opens, displaying a record of previous users who dispensed supplies from the 
position that now has a discrepancy.  

3. Click the Print button if you want to print this list. 

4. Click the Close button to close the window. 

 To set the number of previous accesses to a discrepant position 

1. From the Data menu, select Set Number of Previous Accesses. 

2. In the Set Previous Accesses window, enter the number of accesses you want to view.   

3. Enter the number of days to limit the search for previous accesses. 

When searching for previous accesses, the system stops searching when it has found the 
number of accesses specified in Step 2, or the number of days specified here, whichever 
comes first.  For instance, suppose you enter 5 as the number of previous accesses, and 10 as 
the number of days.  If a position has only been accessed 3 times in the past 10 days, then the 
system stops searching for previous accesses beyond the 10-day limit.  In this case, only 3 
accesses are shown. 

4. Click on OK to close the Set Previous Accesses window. 

The previous access setting is remembered by the system.  You do not need to set this each time 
you want to view previous accesses, unless you want to change the number. 
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Using the Discrepancy Report 

The Discrepancy report is designed to show an audit trail of discrepancies and previous accesses 
that occur for each supply position.  This report provides the list of users who have most recently 
accessed a supply position that was found to be discrepant.  Whenever there is a discrepancy in 
your system, use this report to contact each user to determine whether they can offer information 
that helps to resolve the discrepancy. 

How to Read the Discrepancy Report 
The Discrepancy report lists each outstanding discrepancy, and for each, it shows a list of 
individuals who previously accessed the cabinet.  The number of days of previous accesses shown 
can be set when you print the report. 

If a discrepancy occurs on a shelf that has more than one compartment, then the list of previous 
accesses includes all accesses to that shelf, not just the compartment that has the discrepancy.  In 
other words, you see a list of several accesses to the shelf, but each access may or may not be for a 
different supply in a different compartment. 

Printing the Discrepancy Report and Other Discrepancy Information 
To print information about discrepancies, you must be viewing the Discrepancy Resolution 
window. 

 To print the Discrepancy Report 

Before printing the Discrepancy report, make certain the printer is set to print in landscape mode.  
To print the Discrepancy report, click on the Print Discrepancy Report button.   
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 To print more specific types of information 

To print other information about discrepancies, select the Print option under the File menu.  
You receive four print options.  Choose the option you want, then click on the OK button.  The 
following four choices are available: 

1. List of 
Discrepancies 

This option prints a list of all of the discrepancies in the system. 

2. Current 
Discrepancy 
Detail 

This option prints the detail that is currently displayed on the 
Discrepancy Resolution window. 

3. Previous 
Accesses of 
Current 
Discrepancy 

This option prints information about the previous accesses to the 
discrepant position that is currently highlighted in the browser.  The 
number of accesses shown depends on the number you have specified 
in the Set Number of Previous Access option under the Data 
menu. 

4. Previous 
Accesses of all 
Unresolved 
Discrepancies 
(Discrepancy 
Report) 

This is the same as the Discrepancy Report.  This option prints 
information about the previous accesses to ALL of the unresolved 
discrepant positions that are listed on the Discrepancy Resolution 
window.  The number of accesses shown depends on the number you 
have specified in the Set Number of Previous Access option 
under the Data menu.  This printout may take a long time if you 
have many discrepancies.  If there are more than 20 or 30 
discrepancies, you may want to print only previous accesses for the 
current discrepancy, not all discrepancies, as described in option 3 
above. 
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Importing Supplies 

To reduce or eliminate the need for manual supply entry, data from an on-line supply list can be 
imported into the SupplySource database. The list must meet the following requirements before it 
can be imported: 

• It must exist in a flat file (text) format. 
• The flat file must be tab delimited, dBase II, or dBase III format. 
• The flat file must have, at minimum, the fields marked required in the table below. Other 

fields are optional, and all fields must not exceed the length specified in the table. 

In addition to these requirements, the following rules will be applied to an imported list: 

1. The item code must be unique. Existing records will be updated with new information. New 
records will be added to the database. 

2. If no Nursing Name exists, then Nursing Name = Material Name 
3. If selected for import but value is not valid, then Billing Required defaults to Y 
 

Field Name Type Length 

Supply Material Name (required) Char 50 
Supply Nursing Name Char 50 
Unit of Issue Char 20 
Manufacturer Part Number Char 15 
Item Code (required) Char 15 
Supply Charge Code Char  25 
Supply Max Quantity Number  
Supply Min Quantity Number  
Supply Cost Money 8.2 
Count Remaining Flag Char 1 
Store Room Location Char  25 
Vendor Number Char  15 
Billing Required Char  1 
Customer Defined Class Char 1 

 



 Control Center User’s Guide 87 

 To import a supply list: 

1. Under the Management menu, select Supply Import. 

Supply Import lists all fields that could be a part of your supply list.  

2. Turn off any fields that are not part of your list by removing the check in the Included 
checkbox. 

Some required fields can be unselected. However, if you unselect a required field, no new 
records will be added. Instead, only existing records will be updated. Some required fields 
cannot be unselected. You will be informed if you attempt to unselect one of these fields. 

3. Arrange the order of the fields to match the order of your list.  

To move a field up or down in the list, select the field, then click on the Move Up or Move 
Down button, or drag and drop the field to a new location in the list. 

4. If you want to overwrite any fields in existing records with the imported values, then check 
the Overwrite option for that field name. If you do not select the Overwrite option, then 
values in existing records will not be changed. 

You can save the format that you have defined so that you do not have to configure the fields 
again. Under the Data menu, select Save Column Format. 

5. Next to the Import File field, click on the Browse button to locate the file.  

6. If necessary, select the Skip File Header option to ignore any header information in the 
file. 

7. Click the Import button. 

When you close the window, you may be asked if you want to save the format for the import 
options (only if you have moved fields up or down). Choose Yes to preserve this format on this 
Control Center computer only. If you choose No, the list will open in its default format the next 
time you use this import function. 
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Importing Locations 

Location data can be imported into the SupplySource database.  Location data must meet the 
following requirements before it can be imported: 

• The data must exist in a flat file (text) format. 

• The flat file must be tab delimited, dBase II, or dBase III format. 

• The flat file must have the format defined in the following table (all fields are optional unless 
otherwise noted): 

Field Name Type Length 

Location Number (required) Char 15 
Location Description Char 30 

 
The following rule is applied to an imported location: if no Location Description exists, then 
Location Description = Location Number. 

 To import location data 

1. Under the Management menu, select Location Import. 

Location Import lists all fields that contain location-specific data. 

2. Turn off any fields that are not part of your data by removing the check in the Included 
checkbox. 

Some required fields can be unselected.  However, if you unselect a required field, no new 
records will be added.  Instead, only existing records will be updated.  Some required fields 
cannot be unselected.  You will be informed if you attempt to unselect one of these fields. 

3. Arrange the order of the fields to match the order of your data.   

To move a field up or down in the list, select the field, then click on the Move Up or Move 
Down button. 

4. If you want to overwrite any fields in existing records with the imported values, then check 
the Overwrite option for that field name.  If you do not select the Overwrite option, then 
values in existing records will not be changed. 
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You can save the format that you have defined so that you do not have to configure the fields 
again.  Under the Data menu, select Save Column Format.  

5. Next to the Import File field, click on the Browse button to locate the file. 

6. If necessary, select the Skip File Header option to ignore any header information in the 
file. 

7. Click the Import button. 

When you close the window, you may be asked if you want to save the format for the import 
options (only if you have moved fields up or down).  Choose Yes to preserve this format on this 
Control Center computer only.  If you choose No, the list opens in its default format the next 
time you use this import function. 



Control Center User’s Guide  90

Importing Users 

User data can be imported into the SupplySource database.  User data must meet the following 
requirements before it can be imported: 

• The data must exist in a flat file (text) format. 

• The flat file must be tab delimited, dBase II, or dBase III format. 

• The flat file must have the format defined in the following table (all fields are optional unless 
otherwise noted): 

Field Name Type Length 

User Card Number (required) Numerals only 15 
User Name Prefix Char 4 
User First Name (required) Char 15 
User Middle Name Char 15 
User Last Name (required) Char 15 
User Name Suffix Char 8 

 
All imported user accounts are assigned a PIN of 9999 that must be changed at any Display 
Terminal or Control Center when that user logs in. 

 To import user data 

1. Under the Management menu, select User Import. 

User Import lists all fields that contain user-specific data. 

2. Turn off any fields that are not part of your data by removing the check in the Included 
checkbox. 

Some required fields can be unselected.  However, if you unselect a required field, no new 
records will be added.  Instead, only existing records will be updated.  Some required fields 
cannot be unselected.  You will be informed if you attempt to unselect one of these fields. 

3. Arrange the order of the fields to match the order of your data.   

To move a field up or down in the list, select the field, then click on the Move Up or Move 
Down button. 
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4. If you want to overwrite any fields in existing records with the imported values, then check 
the Overwrite option for that field name.  If you do not select the Overwrite option, then 
values in existing records will not be changed. 

You can save the format that you have defined so that you do not have to configure the fields 
again.  Under the Data menu, select Save Column Format.  

5. Next to the Import File field, click on the Browse button to locate the file. 

6. If necessary, select the Skip File Header option to ignore any header information in the 
file. 

7. Click the Import button. 

When you close the window, you may be asked if you want to save the format for the import 
options (only if you have moved fields up or down).  Choose Yes to preserve this format on this 
Control Center computer only.  If you choose No, the list opens in its default format the next 
time you use this import function. 
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Generating Reports: Using Examiner 
Examiner is a reporting package that you can use to create, customize, and print reports.  
Examiner includes a variety of standard reports that you can view and print without performing 
any customization.  The instructions that follow show you how to access and print these standard 
reports. 

For specific instructions on using Examiner’s many features, or to create or customize your own 
reports, consult the Examiner online help.  

Starting Examiner 

To start the Examiner application, click on the Start button on the Windows Task Bar, select 
Programs, then select MedSelect, then select Examiner 6.0. 

Viewing a Report and Setting Date Ranges 
For some reports, you are prompted to enter a date range for the report information.  If there are 
events listed on a report that do not have a required matching event (such as a Return event with 
no original Taken event), then the date range you specified may be too limiting (for instance, the 
original Taken event occurred before the begin date or time for this report).  You may want to 
generate the report again with a broader date range. 

Viewing a Report from Examiner 
If Examiner is already open, you can view all reports by selecting the Open option under the 
File menu.  Choose the report you want from the available list.    
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Printing a Report 
To print a report that you are viewing, select the Print option under the File menu in Examiner. 

Closing Examiner 
You can close Examiner when you are finished, or leave it running in the background while you 
continue to use the Control Center.   

Standard Reports 

There are four general types of reports that are provided with SupplySource: Refill, 
Management, Configuration and Nursing.  Each of these report types is described in the 
following sections. 

Refill Reports 

The Refill reports are used for picking the supplies needed for restocking the SupplySource 
stations.  See Restock Amounts on page 61 for more information about these reports. 

Refill Warehouse Selection to Maximum—Lists all positions that are below their maximum 
capacity and the quantity needed to restock those positions to their maximum capacity. This 
report would be used to pick the supplies needed to restock all positions to maximum. 

Refill Warehouse Selection Below Minimum—Lists all positions that are below their minimum 
capacity and the quantity needed to restock those positions to their maximum capacity. This 
report would be used to pick the supplies needed to restock only positions that are below 
minimum. 

Refill Warehouse Stockouts - Lists all positions that are at a zero quantity. This report would be 
used to pick the supplies needed to restock only positions that are empty. 

Management Reports   

These reports are used by the Materials Manager to better manage supply utilization.   

Location Dollar Value—Lists all supplies by location and dollar value. This report can be used 
to review the supply stock at each station and current dollar value of each supply at that station.  

Day of the Week Average Usage—Lists the average usage of supplies at a location by day of the 
week.  This report can be used to spot trends in usage of a particular supply by day. For example, 
Sundays average 20 per day, Mondays average 40, etc. 
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Daily Usage—Lists the supplies that have been used at a location, and how many have been 
dispensed of each, within a specified date range. This report can be used to review the exact 
usage of supplies at a location during a certain time period.   

Department Charges and Credits—Lists all supplies that were either charged or credited to a 
specific department because of an inventory discrepancy. When actual inventory is less than the 
system count, the department is charged for the discrepancy (Department Resolved Charge). 
When the actual inventory is greater than the system count, the department is credited 
(Department Resolved Credit). 

Supply Usage by Location Graph—Shows the usage of all supplies in a location in bar graph 
form. This report clearly illustrates which supplies are used the “most popular” and the “least 
popular” at a location. 

Staff Usage by Supply Graph—Shows supply name and cost of all supplies dispensed by each 
staff member in bar graph form. This report illustrates the dispensing history of each staff 
member, and the dollar value of those dispenses. 

Audit Report—Lists all supply positions and their system quantities. Restock technicians can 
use this report to compare quantities on the shelf to the system quantity. 

System Log Message—Documents most errors made in the system. It lists the date and time of 
the error, the interface and window where the error occurred, the type of error committed, and a 
description of the error. It also records user logins and logouts. 

Supply List—Lists all the supplies that are available to be stocked in the SupplySource system. 

Supply Expiration Date—Lists all supplies that are at or near their expiration date (the 
expiration dates must be entered by restock technicians).  This report can be used by restock 
technicians to expire supplies that are unusable. 

Refill Event Summary—Lists all restocking activity.  

Supply Usage by Materials Name—Lists the usage of each supply by location. This can be used 
to pinpoint which departments have higher usage of particular supplies.  

Discrepancy Report—This report is printed at the Control Center, please see page 84. 
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Configuration Reports 

These reports display configuration information.  

Available Positions—Lists positions that do not have supplies assigned to them.  

Configuration—Lists each location, and the towers and controllers that make up that location. 

Position Labels—Used to create “Supply Position” labels that should be affixed to each supply 
position as identification. The label lists the Item Number, Material Name, and Unit of Issue.  
Please see Printing Dispensing Device Labels on page 96 for label specifications.  See the 
SupplySource Restocker’s Guide for complete instructions on the placement of labels.  

Nursing Reports 

These reports are used by the Nursing Manager to manage staff and supplies in their department.   

Nursing Inventory—Lists all supplies by location, sorted by tower. This report is “map” of each 
SupplySource station and can be used to verify the supplies available, and to inform newer staff 
of the supply availability at that station.  It can also be used as a quick way to locate supplies in 
the case when there is a power outage and the cabinets must be accessed by key. 

Staff Access Rights—Lists all users and their access rights. 

Staff Usage by Location—This report lists each staff member’s usage by department, and the 
supplies dispensed by that staff member, along with the dollar value of those supplies.  
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Printing Dispensing Device Labels 

Examiner can generate labels that you can use to identify your supply positions.  Position labels 
can be printed on standard Avery labels using the Position Labels Report (see Configuration 
Reports on page 95).  These labels can be purchased from most office supply vendors.  Print 
labels only after you have assigned a supply to each position.     

Recommended brand: Avery White Removable Multi-Purpose Labels (#AVE6460) 
 (Formerly Remove ‘Em Laser Labels)  

 (1" x 2 5/8" - 30 labels/sheet, 25 sheets/box, 750 total labels/box) 
 

See the SupplySource Restocker’s Guide for label placement instructions.  

The color Position Indicator Labels (included with each SST) also need to be affixed to the 
supply positions.  See the SupplySource Restocker’s Guide for instructions. 
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Control Center Advanced Tools 

Using the Sort Feature 

You can sort information on any browser you are viewing.  To use the Sort feature, follow these 
steps: 

1. While viewing the browser you want to sort, click on the Sort button on the toolbar. 

2. In the Column field, select the field to use for the sort. 

3. Select Asc or Desc to indicate whether you want to sort by ascending (Asc) or descending 
(Desc) order.  

4. To select another field to use for a secondary sort, click on the Add button.  A blank line 
opens for you to define the next field to use in the sort. 

You can also click on Insert to place a blank line between existing lines.  The blank line is 
placed before the currently selected line.  You can use as many fields as you like to define 
the sort.  Click on Delete to delete the currently selected line. 

5. Click on OK.  The sort is performed. 

Example: Sorting the patient browser first by last name, then by location 

1. While viewing the patient browser, click on the Sort button on the toolbar. 

2. In the Column field, select patient_last_name. 

3. Select Asc for ascending order. 

4. Click the Add button. 

5. In the Column field of the new line, select location_number. 

6. Select Asc for ascending order.   

7. Click on OK.  The sort is performed. 
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Using Standard Find, Smart Find, and the Filter 

Using a find window, you can search for information on any browser you are viewing.  Some 
browsers use a detailed find form called standard find, while others use a quicker find form called 
smart find.  To use the find features, click on the Find button on the toolbar.  The title of the find 
window that opens indicates whether it is standard or smart find. 

The filter is similar to the standard find feature, but it “filters out” all of the information you 
haven’t specified, and shows only the information that meets your criteria. 

Standard Find and the Filter 
The following table defines all of the selections you can define when using a filter or the standard 
find feature: 

Heading Definition Options Result 
( Denotes the beginning of a 

sequence of  options 
-Selected 

-Not Selected 
- Indicates the start of a group of options 
- No group of options is desired 

Column Contains a drop-down list of 
all of the fields on the report 
or browser you are using.   

Select a field - The filter sorts by the field you select. 

Operator Defines the parameters of 
the sort.  The Operator 
defines how the Value is 
used by the filter. 

= 
 

< > 
< 
> 

< = 
> = 

begins 
contains 

ends 

- Finds only those items exactly equal to the Value; the 
equals search is case sensitive 

- Finds only those items not equal to the Value 
- Finds all items less than the Value 
- Finds all items greater than the Value 
- Finds all items less than or equal to the Value 
- Finds all items greater than or equal to the Value 
- Finds all items that begin with the Value 
- Finds all items that contain the Value 
- Finds all items that end with the Value 

Value Defines an  exact value, 
such as a name or ID 
number, NOT case sensitive 

-Choose from 
the drop-down 

list 
-Enter a letter 
-Enter a word 

- Enter a number 

- The Value is used to filter the browser or report, 
depending on the Operator you specified.  The value 
field contains a drop-down list of fields on the form, 
but you are not required to choose from the list.  You 
may type in the value you want to specify.  You 
cannot search for double quotes (").  You may search 
for single quotes (’).  

) Denotes the end of a 
sequence of  options 

-Selected 
-Not Selected 

- Indicates the end of a group of options 
- No group of options is desired 

And/Or Prioritizes multiple options -And 
-Or 

-Blank 

- Finds more than one option 
- Finds only one or the other option 
- No options are desired 
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The filter and standard find features include Add, Insert, and Delete buttons.  Use these 
buttons to add, insert, or delete data entry lines.  If you add lines before you enter any data, the 
And/Or field defaults to And, but you can change this to Or if you like. 

______________________________________________________________________________  

Note: While performing a filter or find, you can specify a search for information in a field that 
is either blank or not blank.  To specify a search for a field that is blank, specify = in the 
Operator field, and do not put any data in the Value field.  To search for any 
information except a blank field, specify < > in the Operator field, and do not put any 
data in the Value field. 

______________________________________________________________________________  

The following examples illustrate the use of a the standard find and filter features: 

Example: Finding all users with a disabled login 
This example shows you how to quickly locate any record that matches the search criteria, in this 
case, any user with a disabled login.  Follow these steps: 

1. Under the Maintenance menu, select User, and then select User Browser. 

2. Click the Find button on the toolbar. 

3. In the Column field, select disable_login_flag. 

4. In the Operator field, select =. 

5. In the Value field, type Y (the = search is case sensitive, so you must type a capital Y).  

You should now have a find that reads: (disable_login_flag = Y).   

6. Click on OK.  The browser now highlights the first record of a user with a disabled login. 

7. To find the next user with a disabled login, press CTRL+N.  Do this to find each 
consecutive user with a disabled login. 
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Example: Filtering for all users with a disabled login 
This example functions much like the find you performed in the previous example, but the result 
is different.  Instead of finding the record among the list of all records in the browser, the 
browser is refreshed to show only those records that meet the search criteria.  Follow these steps: 

1. Under the Maintenance menu, select User, and then select User Browser. 

2. Click the Filter button on the toolbar. 

3. In the Column field, select disable_login_flag. 

4. In the Operator field, select =. 

5. In the Value field, type Y (the = search is case sensitive, so you must type a capital Y).  

You should now have a filter that reads: (disable_login_flag = Y).   

6. Click on OK.  The browser is refreshed to show only those records that meet the search 
criteria. 
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Resetting the Filter 
After you have used the filter to filter a browser, you can reset the display to its original list or 
information.  To reset the filter and restore the previous display, under the Data menu, select 
Reset Filter. 

Smart Find 
When you are viewing a browser like the Patient browser or Supply browser, you can locate a 
specific item using Smart Find.  To locate an item, follow these steps:  

1. While viewing a browser, click on the Find button on the toolbar. 

2. Click on the corresponding radio button to indicate the type of information you are looking 
for. 

3. In the text box, type the name of the item you want to find. 

4. Click the Find Next button to find each consecutive occurrence of the item. 

5. Click the Close button to close the Smart Find window. 

Example: Using Smart Find to find all patients with a last name of Smith 
 

1. Under the Management menu, select Patient. 

2. Click the Find button on the toolbar. 

3. Click the Last Name radio button. 

4. In the text field, type smith (the search is not case sensitive).   

As you are typing, you see the browser selection jump to the first occurrence of the name 
Smith. 

5. Click the Find Next button to find each consecutive patient named Smith. 

6. Click the Close button to close the Smart Find window. 
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Data Entry Shortcuts 

Some system users may prefer using keyboard shortcuts instead of the mouse for frequently used 
functions.  The following list shows keyboard shortcuts you can use on most windows in the 
Control Center: 

Shortcut Keys Function 
CTRL+A Add 
CTRL+C Copy Selection 
CTRL+D Delete Selection 
CTRL+F Find 
CTRL+I Insert 
CTRL+N Find Next 
CTRL+P Print 
CTRL+S Save 
CTRL+X Cut 
CTRL+Y Paste Copied Item 
CTRL+Z Undo 
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Data Entry Fields 
This section lists the Control Center windows in alphabetical order, and defines each of the data 
entry fields on those forms.  Required fields are underlined and highlighted. 
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Cabinet Configuration Fields 
 

Cabinet Description A name that describes this SST.  Every cabinet in the same 
location must have a unique description.   

Location The location of the cabinet.  Choose the location from the drop-
down list. 
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Client Configuration Fields 
 

Node Name The node name is a unique name (up to 16 characters) that 
identifies the computer that is running the client application.  
This can be any valid TCP/IP node name.  Examples of valid 
node names are NWS3 or NWS_OR.    The node name can 
contain a hyphen or underscore, but cannot contain spaces or 
special characters.  Each computer’s node name must be 
unique.   

Multiple applications can be installed on the same computer; in 
this case, each application is assigned to the same node name. 

Department The department where the client is located. 

IP Address The client computer’s assigned IP address, which must be 
provided by the hospital’s Information Systems personnel.  The 
format for the IP address is ###.###.###.### where each ### 
segment can be a 1, 2, or 3 digit number. 

Application Type The type of application, such as Control Center. 

Application Name A name given to identify the application.  When a new record 
is created, a default Application Name is created by combining 
the Node Name with the Application Type.  You can use this 
default name or edit the field to be any name you wish to use. 

Version The version number of the software application that is currently 
running on the computer you have identified by node name.  
When you first add a client, the version is blank.  The version 
number is only shown after the client application has been run 
for the first time. 

CC Auto Logout 
(Properties) 

The length of time, in seconds, that the Control Center 
application may sit idle before automatically logging out the 
user. 

Report Criteria 
(Properties) 

The number of days that should be retrieved on the Discrepancy 
report. For example, the number 5 indicates that the report 
show data from today and the past five days. The default value 
is 7. 
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Controller Configuration Fields 
 

Address The number assigned to the processor chip on the 
Controller. Maximum of 8 characters. 

Type Description A description of the device.  This field is filled in 
automatically when you tab out of the Address field. 

Display Terminal The node name assigned to the Display Terminal that 
powers this Controller.  Choose the Display Terminal from 
the drop-down list. 

Cabinet Description Identifies the SST that contains this Controller.  Choose the 
description from the drop-down list. 

Sequence Number The number that describes the physical order of controllers 
when there is more than one.  For example, a SST has 16 
possible shelf controllers; the top controller has a sequence 
number of 1, the next lowest has a sequence number of 2, 
and so on.  A SST Electronic Lock controller will always 
have a sequence number of 1 (there is only 1 per SST). 

Controller 
Configuration 

The numbers that describe the configuration of the devices 
attached to the controller.  Choose the configuration of an 
Electronic Lock from the drop-down list.  A Shelf controller 
will default to 18  (the maximum number of positions per 
shelf). 
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Department Maintenance Fields 

 
Department Options: 

Department  A name you create to identify a department. 

DT Timeout  The length of time, in seconds, that a Display Terminal can be idle 
before automatically logging out the user. 

DT Restock Timeout  The length of time, in seconds, that a Display Terminal can be idle 
during a restock before automatically logging out the user.  This is 
usually longer than the regular DT Timeout. 

DT Patient Usage Indicates how many past hours’ worth of time the Display Terminal 
should use to show patient usage information.  For instance, a value 
of 48 indicates that the Patient Usage window shows all patient 
usage for the past 2 days.  The default is 72 hours. 

ID Card  Leading 
Digits and Trailing 
Digits 

These values determine how a user’s ID string is read from a swipe 
card.   

Lead digits indicates how many numeric characters should be 
ignored at the beginning of the string.  Alpha characters are 
automatically ignored.  For example, if the lead string is A000, then 
Lead Digits should be set to 3 (because the "A" is ignored.) 

Trail digits indicates how many numeric characters to ignore at the 
end of the string but prior to the = sign.  Every character after the = 
sign is ignored.  All alpha characters in the trailing digits are also 
ignored.  For example, if the string ends with 0A00=0B and the 
Trail Digits is set to 3, then the 0A00 is ignored.  The 0B is also 
ignored because it appears after the = sign. 
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Department Maintenance Fields (continued) 

Display Terminal Options: 

Find Patient by ID  If checked, indicates that when a user performs a patient find at a 
Display Terminal, the Patient ID field is an option for specifying 
find data.  Otherwise, the patient ID field is not an option for a 
patient find. 

Not Available for 
Find/Add 

If checked, indicates that patients in this department cannot be 
"found" by other departments when they do a patient search.  The 
patient can still be found if searched for within its own department. 

PIN Required If checked, users must enter a PIN Number to log in. Not checked by 
default. 
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Department Maintenance Fields (continued) 

Display Terminal Sorting: 
 

Supply Name Allows you to select the default display format for supplies listed in 
the Supply Browser. You can choose to show supplies by their 
Material or Nursing Name. 

Patient Browser Allows you to select the default sort order for patient records listed 
on the Patient browser.  You can choose to display records 
alphabetically in order by patient name or the room description. 

StockIt Window Allows you to select the default sort order for supplies listed on the 
StockIt window.  You can choose to display supplies by position or 
supply name. 

Usage Browser Allows you to select the default sort order for transactions listed in 
the Usage browser, which shows all supply transactions for a 
particular patient.  You can choose to list the transactions in order 
chronologically by the date of the event, or alphabetically by the 
name of the supply involved. 
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Discrepancy Resolution Fields 

Browser Fields: 

 
Event Date The date and time when the user reported the discrepancy. 

Event Status The type of event that was being transacted when the 
discrepancy occurred, such as Taken or Returned. 

Res Stat The status of the event that the system generated to resolve 
the inventory count.  The following statuses are possible: 

Dpt Chrg Department Charge: this applies an additional 
charge to the department to make up for a 
discrepancy in which the system count is higher 
than the user corrected count. 

Dpt Cred Department Credit: this credits the department to 
make up for a discrepancy in which the system 
count is below the user corrected count.  

Pat Cred Patient Credit: this credits the patient account to 
make up for a discrepancy in which the system 
charged the patient for a supply that was never 
administered to that patient. 

DT The Display Terminal where the discrepancy was noticed and 
reported. 

Supply Nursing Name The nursing name of the supply that is discrepant. 

User The user who reported the discrepancy. 

Res Indicates whether or not the discrepancy has been resolved by 
showing Yes or No. 
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Discrepancy Resolution Fields (continued) 

Detail Fields: 

 
Patient The patient for whom the supply was dispensed. 

Supply 
Material 
Name 

The manufacturer’s brand name for the supply that was dispensed. 

Supply 
Position 

The dispensing position from which the supply was dispensed. 

Room/Bed The room and bed assigned to the patient. 

Unit of 
Issue 

The unit of measurement used to describe the volume of the supply that 
was dispensed. 

Quantity 
Dispensed 

The number of supply items dispensed during this dispensing event. 

Resolved If checked, indicates that you understand why the discrepancy occurred 
and that the discrepancy is resolved. 

Resolution 
Description 

A textual description you enter to explain why the discrepancy occurred, 
how it was resolved, etc.  Maximum of 1000 characters.  The name of the 
person who is logged in to the Control Center is appended to the 
description when it is saved. 
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Display Terminal Configuration Fields 
 

Node Name The node name is a unique name (up to 16 characters) that 
identifies the Display Terminal.  Examples of valid node names are 
DTORROOM or DTEYELAB.  MedSelect encourages the use of 
DT as the first two letters of the node name.  The node name can 
contain a hyphen or underscore, but cannot contain spaces or 
special characters.  The node name must be unique.   

Department The department where the Display Terminal is located. 

Location The location of the Display Terminal.  Choose the location from the 
drop-down list.  This location is the default location, but you can 
assign other locations as well.  Note that if you change the default 
location, the old default location continues to be assigned to the 
Display Terminal as a non-default location. 

IP Address The Display Terminal’s assigned IP address, which must be 
provided by the hospital’s Information Systems personnel.  The 
format for the IP address is ###.###.###.### where each ### 
segment can be a 1, 2, or 3 digit number. 

Logging This determines the level of detail that is recorded in the Display 
Terminal’s error log.  The following logging options are available: 

0  Indicates no logging. 

1 Indicates status logging only.  Status logging records 
information such as log in, log out, offline change, and online 
change.  

2 Indicates debug logging.  Debug logging records Display 
Terminal activities in detail, and can be used by MedSelect 
support personnel when troubleshooting the system. 

The default setting is 1.  You should use this default unless 
otherwise instructed by MedSelect. 

Receipt Printer Check this box if the Display Terminal has an attached receipt 
printer. 
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Economy Tower Bins Fields 
 

Cabinets The economy cabinets in the database.  Choose the SST you would 
like to configure from the drop-down list. 

Doors The list of doors that make up the above cabinet.  One or more 
shelves will reside behind each door. 

Bins The compartments created behind each door using the Auto-
Generate or Add button.   
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Facility Maintenance Fields 
 

Facility Name The name of the facility.  Maximum of 60 characters. 

# Login Tries The number of times a user can unsuccessfully attempt to log in 
to a Display Terminal or Control Center before that user’s 
account is disabled.  An unsuccessful login means that the user 
entered the correct login ID but an incorrect PIN. 

DT Find Closed 
Visit 

If checked, indicates that a patient find performed at a Display 
Terminal searches for closed as well as open visit records.  
Closed visit records are shown only when there is no open or on-
hold visit to display. 

Positive 
Identification 
Login Required 

If checked, indicates that all users in your facility must use a 
swipe card to log in to the Display Terminal.  Logging on by 
manually entering a login ID is not permitted.  The user is 
required to enter a unique PIN number in addition to using the 
swipe card. 

Product Release 
Number 

The version of the Control Center software you are running.  
This field cannot be edited.  You may need to provide this 
number when calling MedSelect for support. 
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Location Maintenance Fields 
 

Location Number A number that identifies the location.  The number can include 
letters, up to 15 characters. 

Location Description A description that can be used to help you identify the location.  
This description is not used in the system.  It is used only on the 
Location Maintenance window. 
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Patient Detail Fields 
 

ID Number A number assigned by your facility to uniquely identify a patient.  
Maximum of 20 characters.  (Note: if this field is blank in an existing 
record, then the patient was added at the Display Terminal.  If you 
make any modifications to the record at the Control Center, then you 
must also fill in this field before saving.) 

Prefix Titles such as Dr., Mr., Ms., etc.  Choose the title from the drop-down 
list. 

First The patient’s first name or initial.  Maximum of 15 characters. 

Middle The patient’s middle name or initial.  Maximum of 15 characters. 

Last The patient’s last name.  Maximum of 15 characters. 

Suffix Descriptors that follow a name, such as Jr., III, M.D., Ph.D., etc. 

Address 1 The first line of the patient’s address.  Maximum of 30 characters. 

Address 2 The second line of the patient’s address.  Maximum of 30 characters.  

City The city where the patient resides.  Maximum of 30 characters. 

State The state where the patient resides.  Maximum of 15 characters. 

ZIP The patient’s ZIP code.  Maximum of 10 characters. 

Country The country where the patient resides.  Maximum of 30 characters. 

Home Phone The patient’s home telephone number.  Maximum of 14 characters. 

Birthdate The patient’s date of birth (mm/dd/yyyy). 

Gender The patient’s gender (choose Male, Female, Unknown, or Other from 
the drop-down list). 

MRN The Medical Record Number assigned to this patient.  Maximum of 
20 characters. 

Allergies A description of any relevant drug allergies the patient may have. 
Maximum of 450 characters. "NKA", "None" or "No Known 
Allergies" will appear in this field if the patient has no allergies or no 
known allergies. 

External Patient 
ID 

Unique identifier for a patient to an external hospital system.  
Maximum of 45 characters. 
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Patient Detail Fields (continued) 
 

External System ID Unique identifier for a patient to an external hospital system.  
Maximum of 20 characters. 

Admission Date The date (mm/dd/yyyy) and time (hh:mm:ss) that the patient was 
admitted. 

Location The room where this patient is staying.  Choose a location from 
the drop-down list. 

Bednumber A number that identifies the bed assigned to this patient.  
Maximum of 8 characters. 

Class A description of the circumstances of the patient’s admission 
(choose Inpatient, Outpatient, Emergency, Pre-admit, or Re-
occurring from the drop-down list).   

Height The patient’s height.  Maximum of 10 characters. 

Weight The patient’s weight at the time of admission.  Maximum of 10 
characters. 

Admitting Physician The name of the physician who admitted the patient.  Choose the 
physician from the drop-down list. 

Visit Number A unique number assigned by your facility to identify this 
patient’s visit. (Note: if this field is blank in an existing record, 
then the patient was added at the Display Terminal).  If you make 
any modifications to the record at the Control Center, then you 
must also fill in this field before saving).  Maximum of 15 
characters. 

External Account 
Number 

Unique number representing a patient billing account within the 
hospital.  Maximum of 20 characters. 

Status The current status of the patient’s visit (choose Open, On-hold, or 
Closed from the drop-down list).  Only open visits are displayed 
on SupplySource Display Terminals. 

Close Date The date (mm/dd/yyyy) and time (hh:mm:ss) that this visit status 
was changed to closed. 

Discharge Date The date (mm/dd/yyyy) and time (hh:mm:ss) that this patient was 
released from your facility. 

Admin User The administrator who last updated this visit. 
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Supply Assignment Fields 
 

Expiration Date The earliest date when a supply in a position expires.  To clear the 
expiration date, select the field by double-clicking on it, then press 
the spacebar. 

Lot # The manufacturer’s lot number for the supply with the earliest 
expiration date. 

Minimum Quantity The minimum quantity of this supply that you want to keep 
stocked at this position.  The supply should be re-ordered when it 
reaches the Minimum Quantity.  When a supply is stocked in 
multiple positions, it is recommended that the minimum for each 
position be set to 1 (see Assigning Supplies to SupplySource on 
page 76 for an explanation). 

Maximum Quantity The maximum quantity of this supply that you want to keep 
stocked at this position.  Maximum quantities prevent over-
stocking. 

 
See Supply Detail Fields on page 119 for a description of all other fields used on the Supply 
Assignment form. 
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Supply Detail Fields 
 

Material Name The manufacturer’s proprietary, US trademarked name for a supply.    
Maximum of 50 characters. 

Nursing Name The general, chemical, or non-brand specific name for a supply.  You are 
not required to enter a Nursing Name, but if no Nursing Name is entered, 
then the Material Name is copied and used. Maximum of 50 characters. 

Item Code A unique number assigned by your facility to identify a supply.  
Maximum of 15 characters. 

Unit of Issue The type of unit the supply is issued in, for example, box, bag, etc.  
Maximum of 8 characters. 

System 
Quantity 

The actual quantity of the supply currently stocked in SupplySource.  
This quantity cannot be changed at the Control Center, but can be edited 
only at the Display Terminal. 

Minimum 
Quantity 

The minimum system-wide quantity of this supply that your facility wants 
to keep stocked in SupplySource.  The supply should be re-ordered when 
it reaches the Minimum Quantity.  Some industries may refer to this as 
the par quantity for an item. 

Maximum 
Quantity 

The maximum system-wide quantity of this supply that your facility 
wants to keep stocked in SupplySource.  Maximum Quantities prevent 
over-stocking. 

Charge Code A hospital assigned code that indicates the charge for this supply.  
Maximum of 25 characters. 

Cost The latest cost per unit of the supply. 

Billing 
Required 

If checked, indicates that any dispenses of this supply should be sent to 
the billing interface. 

Return to 
Original 
Drawer 

Checked by default, indicates that the user must return this supply to the 
position from which it was originally taken.   
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Supply Detail Fields (continued) 
 

Customer Defined Class 
(See page 47) 

The class assigned to this supply by the Administrator. The 
Administrator can give permission to restock and/or dispense 
this class to individual users and user groups. 

Vendor Number A number assigned by the vendor to identify its product.  
Alternatively, you may wish to use this field to specify a 
number that identifies the vendor to your facility.  Maximum of 
15 characters. 

Store Room Location A description of the location within the hospital where this 
supply is located.  Maximum of 25 characters. 

Manufacturer Part 
Number 

The number assigned to this supply by the manufacturer. 
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User Detail Fields 
 

Name Prefix Titles such as Dr., Mr., Ms., etc.  Choose the title from the drop-
down list. 

First Name The user’s first name or initial.  Maximum of 15 characters. 

Middle Name The user’s middle name or initial.  Maximum of 15 characters. 

Last Name The user’s last name.  Maximum of 15 characters. 

Name Suffix Descriptors that follow a name, such as Jr., III, M.D., Ph.D., etc. 

ID Card Number A number that may be used to log in to the Display Terminal.  This 
number may be encoded on a magnetic swipe card, or typed in 
manually at the Display Terminal Login window.  Maximum of 9 
numbers. 

Username A unique name that identifies the user to SupplySource.  For 
instance, you may want to assign each user a name by combining 
the first name with the last initial.  In this case, John Jones would 
be johnj.  This name is used for logging in to the Control Center, 
and is not required if the user is not to be given access to the 
Control Center.  Maximum of 15 characters. 

Group Profile The group profile, which includes associated access rights, that has 
been assigned to this user. 

Disable Login If checked, indicates that this user account has been disabled and 
cannot be used to log in to SupplySource. 
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User Detail Fields (continued) 
 

Access Rights 

 
System: 

Control Center Login  This right allows the user to log in to the Control 
Center, view patient info, and print reports. 

Account Adjustment  This right allows the user to transfer events between 
patient accounts using Account Adjustment, and to 
assign unknown events to patient accounts using 
Inventory Adjustment. 

Administrate  This right gives the user the ability to maintain user 
accounts, including group profiles.  It also gives the 
user the ability to maintain facility and department 
information.   

At the Display Terminal, this right gives the user the 
ability to add temporary users. 

Configuration  This right gives the user the ability to modify the 
system configuration information. 

Discrepancy Resolution  This right allows the user to resolve discrepancies at the 
Control Center.    

Inventory  This right allows the user to add, update, and delete 
supply information through the Control Center.  This 
right also allows the user to assign supplies to positions, 
adjust supply minimum and maximum quantities, and 
expire supplies. 
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User Detail Fields (continued) 
 

Access Rights (continued) 
 

Maintenance  This right allows the user to add, update, or delete Location information.  
It also allows the user to use Location Import. 

At the Display Terminal, this right allows the user to exit the Display 
Terminal application by displaying an Exit button on the Patient 
browser.  The button is only displayed to users with the Maintenance 
Right. 

Patient 
Management  

This right allows the user to add, update, and delete patient information, 
and to close visit records at the Control Center. 

Users without this right may still view patient information.   

This right has no impact on the user’s ability to add a patient at the 
Display Terminal.  All users with DT Login rights may add patients at 
the Display Terminal. 

Display Terminal: 

SS & DT 
Login  

This right allows the user to log in to a Display Terminal, dispense 
supplies, and add or find patients at the Display Terminal. A user who 
attempts to log in to a Display Terminal must also be assigned to the 
same department as that Display Terminal. 

Restock  This right allows the user to enter the Restock Browser.  Once in the 
Restock Browser, the user must have the Restock right for the supply in 
the position being restocked.  

Defined Class: 

Dispense and 
Restock Rights 
Defined by 
Administrator 

These rights allow the user to restock and/or dispense classes of 
supplies previously defined by the administrator through the Control 
Center. If no classes are defined, this area will be empty.  (See page 
47.) 
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